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Preface

Preface

ClearCount is a central count paper-based optical scan voting system. ClearCount
utilizes modern software architecture and scalable unmodified commercial-off-
the-shelf (COTS) hardware to provide a faster, lower cost, and higher performing
election experience.

Audience and scope

This guide describes how to install and configure ClearCount software and
supporting hardware and software in preparation for an election. The intended
audience includes system administrators and election officials.

For information on working with the ClearCount system during an election, please
see ClearCount Election Administrator's Guide.

Using this guide
This guide describes how to install and configure the ClearCount system and

prepare for an election.

Chapter 1. About Ballot Definition Files

Describes how Ballot Definition Files are created and used.

Chapter 2. Installing ClearCount software

Explains how to install ClearCount software on the system ScanServer.

Chapter 3. Configuring ScanStations

Explains how to install and configure scanner software on ScanStation computers.

Chapter 4. Configuring Election Administration Stations

Explains how to install and configure software on Election Administration stations.

Chapter 5. Hardening, validating, and securing the system

Explains how to secure the ClearCount system and ensure it is operating properly.

Chapter 6. Setting up the scanning location

Explains how to prepare physical elements of a site for scanning ballots.

Xi



Preface

Chapter 7. About target cards and box labels

Explains how to prepare physical target cards and box labels for the scanning
process.

Chapter 8. Creating elections and users

Explains how to create and manage elections and users.

Chapter 9. ClearCount readiness testing

Explains how to ensure the ClearCount system is in proper working order prior to
the start of the election.

Chapter 10. ClearCount logic and accuracy testing

Explains how to verify that ClearCount is tabulating ballots as expected.

Chapter 11. Uninstalling ClearCount

Explains how to remove ClearCount and supporting software.

Chapter 12. Breakdown and storage

Explains how to break down and store ClearCount equipment after an election.

Appendix A. Installation checklist

Provides a printable checklist for recording user names and passwords entering in
the process of installing ClearCount software.

Contact Us

Clear Ballot Group welcomes your feedback on our documentation. Please send
your comments to Documentation@ClearBallot.com.

Xii



1.1 About Ballot Definition Files

Chapter 1. Defining elections

Jurisdiction officials can work with Clear Ballot to audit elections. In each instance,
Clear Ballot creates a Ballot Definition File (BDF).

1.1 About Ballot Definition Files

The BDF is a unique file for each election that records all necessary options for
casting and recording votes. BDFs enable the ClearCount software to successfully
register ballot images and tabulate vote targets. Registering a ballot image
consists of matching its coordinates to the normalized coordinate system for the
ballot type in question.

The BDF uses the standard comma separated value (CSV) format to describe such
things as the ballot style, the precinct, and each contest name and its associated
choice names, and the coordinates of the corresponding vote targets.

Clear Ballot creates the BDF by analyzing and interpreting the election’s ballot
style PDFs, which are supplied by the jurisdiction. When the election is created,
the ClearCount software processes the BDF in order to create and initialize a
MySQL database on the ScanServer™.

1.1.1 Scheduling BDF creation and transfer

The following table details the schedule and steps for software and ballot
installation, including key dates, events, and deliverables.




Chapter 1. Defining elections

Table 1-1. BDF Workflow

. Date | Event [ Relateddeliverable

At least 45 days before Election officials use their  Ballot style PDFs for each
Election Day primary EMS to produce precinct in the election.
ballot style PDFs, and then
securely transmit ballot
style PDFs to Clear Ballot.

Election officials install Expected hash code and
ClearCount software and version information.
verify that is has been

properly installed.

30 days before the election Clear Ballot creates a Completed BDF.
Ballot Definition File (BDF)
from the ballot style PDFs
and transmits it securely to
the election officials.

30 to 15 days before the Perform readiness and L&A Readiness and L&A test
election testing on software and results.
BDF.

1.1.2 Transferring files with Clear Ballot

When the jurisdiction engages with Clear Ballot, Clear Ballot establishes an
account and emails the jurisdiction a link to its secure download utility. The
jurisdiction uses this utility to send its ballot style PDFs to Clear Ballot as well as to
retrieve the BDF from Clear Ballot.

To send your ballot style PDFs to Clear Ballot:

1. Click the link in the PDF solicitation email you receive from Clear Ballot.

2. Signinon the Your Information page.




1.1 About Ballot Definition Files

3. Click Continue to Download Page.

G~
Cloar Balot

formatior

Figure 1-1. Clear Ballot Your Information page
4. Inthe Upload Files page, click Choose Files.
5. Browse to the archive (.zip) file of your PDFs and click Open.

G
Cloor Dallot

ET=T

Figure 1-2. Clear Ballot Upload Files page

6. Click Upload Files.

7. After you receive the Files Uploaded Successfully page, close the
browser.
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When the BDF is ready to download, Clear Ballot sends an email message to the
jurisdiction. The message contains a download link to the secure download utility,
as well as two SHA-256 digests, one for the PDF zip file you uploaded, and one for
the downloaded BDF zip file. These digests, which consist of a string of letters and
numbers and the file name, can be used with any SHA-256 compliant hash tool to
validate these files. If you note any discrepancies, contact Clear Ballot
immediately.

To obtain your BDF:

1.
2.

Click the link in the email your received from Clear Ballot.

Sign in on the Your Information page, and click Continue to Download
Page.

C4
Cloar Ballot

At

Figure 1-3. Clear Ballot Your Information page
From the Download page, locate the BDF zip file and click Download.

In the Opening dialog, select Save File and click OK.

Close the browser.




1.2 About Comparison Result Files

1.1.3 Logging the BDF

ClearCount logs the file digest of the BDF used to create the election, so that you
can verify that you installed the same BDF that Clear Ballot transmitted.

When the election is created, the SHA-256 file digest of the BDF is logged to both
the Election Activity Log and the Web Activity Log, as shown in the following
example:

Tabulator 007 - General Election, Nov 6, 2012, Monroe County, NY
Election Activity Log

Start Date ‘ End Date: 2014 Change

Time Source

Figure 1-4. BDF File Digest in the Election Activity Log

This file digest must match the one sent by Clear Ballot. If it does not, contact
Clear Ballot immediately.

1.2 About Comparison Result Files

A Comparison Result File, or CRF, is a file that presents the results export of the
comparison system in a canonical import format that ClearCount can consume. It
allows jurisdictions to compare ClearCount results with the results of the
comparison system.

. By their nature, comparison results are not available until after the
close of polls.

1.2.1 Scheduling transfer of comparison system results

Jurisdictions should sent the results export of their comparison system to Clear
Ballot as soon as results are available after the close of polls. Clear Ballot creates
the CRF from these results and sends it to the jurisdiction. The CRF can then be
imported into ClearCount as long as the corresponding election exists in the
system. The CRF can be imported either before or after ballots are scanned and
tabulated by ClearCount.
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1.2.2 Sharing results files with Clear Ballot

The jurisdiction uses the secure download utility described in Transferring files
with Clear Ballot on page 2 to send its comparison results to Clear Ballot.

Comparison results, in whatever file format created by the comparison system,
should be collected in a zip file.

To send your comparison results to Clear Ballot:
1. Click the link in the CRF solicitation email you receive from Clear Ballot.

2. Signin on the Your Information page, and click Continue to Download
Page.

Cd
Cloar Balot

atior

= Contewe 1 Download Page

Figure 1-5. Clear Ballot Your Information page

3. Inthe Upload Files page, click Choose Files.
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4. Browse to the archive (.zip) file of your CRFs and click Open.
&

Cleor Dallot

Figure 1-6. Clear Ballot Upload Files page

5. Click Upload Files.

6. After you receive the Files Uploaded Successfully page, close the
browser.

When the CRF is ready to download, Clear Ballot sends an email to the jurisdiction.
This email message contains a download link to the secure download utility, as
well as two SHA-256 digests, one for the zip file you uploaded, and one for the
downloaded CRF zip file. These digests, which consist of a string of letters and
numbers and the file name, can be used with any SHA-256 compliant hash tool to
validate these files. If you note any discrepancies, contact Clear Ballot
immediately.

To obtain your CRF:
1. Click the link in the email your received from Clear Ballot.

2. Signin on the Your Information page, and click Continue to Download
Page.

3. From the Download page, locate the CRF zip file and click Download. CRF
archive files are named using the convention Election_Name.crf.zip (for
example, fl_leon_2010g.crf.zip).

4. Inthe Opening dialog, select Save File and click OK.

5. Close the browser.




Chapter 2. Installing ClearCount software

A complete ClearCount system consists of one ScanServer™, one or more
ScanStations™, and one or more Election Administration Stations, joined together
by a closed, wired Ethernet network. The ClearCount software itself is installed
only on the ScanServer, not on the ScanStations or Election Administration
Stations.

. Minimum computing hardware and operating system specifications
are provided in Supported Configurations, ClearCount. This document
is available from Clear Ballot service personnel.

. As part of the installation process, the ClearCount software overwrites
the existing operating system on the ScanServer computer with its
own Ubuntu Linux operating system. If necessary, back up data that
resides on the computer before launching the ClearCount installer.

The ClearCount installation generally takes 15 to 30 minutes. Files are installed at
several different points in the process. You are asked to create and/or remember
several user names, passwords, and IP addresses during the installation. For your
convenience, this guide contains a form you can print and use to track these
items. See ClearCount installation checklist on page 144.

. Maintain this information in a safe and secure location.

In general, if you make a mistake at any point in the installation, the best practice
is to quit the installation and start again from the beginning. There is no need to
uninstall. The Go Back options in this installation wizard sometimes lead to a
summary of the preceding steps rather than to the previous screen.
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2.1 Installing ClearCount

To run the ClearCount installation wizard on the ScanServer computer:

1. Ensure data residing on the computer is backed up.

. Election data must be archived through ClearCount before

installing the upgrade. See ClearCount Election Administrator's
Guide, Backing Up an Election for instructions.

2. Ensure no external drives are mounted.

3. Start the installation:

a.

Turn on the ScanServer computer. (Press the power button if the
computer is already on.)

. Immediately press the key that accesses the startup menu. (For

example, if using an HP computer, press Esc to access the startup
menu.)

. The key used depends upon computer make and model;
consult your computer’s documentation for details. To
access the startup menu, you must press the key very
quickly. If Windows begins to launch, it is too late. Restart
the computer and try again.

. Insert the ClearCount DVD into the CD/DVD drive on the ScanServer

computer.

. Press the function key that accesses the BIOS boot menu. (For

example, if using an HP computer, press F9.)

. From the BIOS boot menu, select the CD/DVD drive. (For example, if

using an HP computer, select Optical Disk Drive and press Enter.)

. Later in this procedure, the computer boots from DVD
instead of the hard drive.

The installation wizard launches.

. The installation procedure advances from screen to screen.
Delays can occur between screens.
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4. Inthe Language screen, accept the default, English, by pressing Enter.

Language

Amharic Frangais MaKeaqoHCku Tamil

Arabic Gaellge Malayalam S 0K
Asturianu Galego Marathi Thai
Benapycras Gujarati Burmese Tagalog
BLbArapCKu My Nepali Turkce
Bengall Hindi Nederlands Uyghur
Tibetan Hrvatski Norsk bokmal YepalHcora
Bosanski Magyar NoOrsk nynorsk Tiéng ViEt
Catala Bahasa Indonesi: Punjabi (Gurmukhi)
Cestina [slenska Polski

Dansk Italiano Portugues do Brasil
Deutsch 8% Portugués

Dzongkha Johaype Romand

EANOVLE Kasarx Pycckmi
g Khmer Samegillii
Esperanto 33 3 u e
Espanol = (| Slovencina
Eesti Kurdi Slovenscina
Euskara Lao shaip
Lietuviskai Cpnckn

Latviski Svenska

Figure 2-1. Ubuntu Language screen

5. Inthe Ubuntu splash screen, select Install ClearBallot Ubuntu Server
and press Enter.

ubuntu®

Figure 2-2. Ubuntu splash screen

10



Chapter 2. Installing ClearCount software

6. Inthe Select a language screen, accept the default, English, by pressing
Enter.

1 ]

Choose the language to be used for the installation process. The
selected language will also be the default language for the installed
system.

Language:

Albanian Shaip
Arabic o
Asturian Asturianu
Basque - Euskara
Belarusian Benapycxas
Bosnian Bosansk {
Bulgarian Bwarapcxn
Catalan Catala
Chinese (Simplified) R (%)
Chinese (Traditional) hw(ER)
Croatian P_'F';'BY’J‘ |
Czech Cestina
Danish Dansk
Neder lands
English

Figure 2-3. Ubuntu Select a language screen

7. Inthe Select your location screen, accept the default, United States, by
pressing Enter.

The selected location will be used to set your time zone and also for
example to help select the system locale. Normally this should be the
country where you live,

This is a shortlist of locations based on the language you selected.
Choose "other" if your location is not listed.

Country, territory or area:

Botswana
Canada

Hong Kong
India
Ireland

New Zealand
Nigeria
Philippines
Singapore
South Africa

United Olnﬁoan

Figure 2-4. Ubuntu Select your location screen

11



2.1 Installing ClearCount

8. Inthe first Configure the keyboard screen, accept the default, No, by
pressing Enter.

Machine View Devices Help

You can try to have your keyboard layout detected by pressing a
series of keys. I1f you do not want to do this, you will be able to
select your keyboard layout from a list,

Detect keyboard layout?

<Go Back

Figure 2-5. First Ubuntu Configure the keyboard screen

9. Inthe second Configure the keyboard screen, accept the default, English
(US), by pressing Enter.

Machine View Devices Help

11 nf igure the ¥ rd |

The layout of keyboards varies per country, with some countrlies
having multiple common layouts. Please select the country of origin
for the keyboard of this computer,

Country of origin for the keyboard:

Burmese

Catalan

Chinese

Croatian

Czech

Danish

Dhivehi

Dutch

Dzongkha

English (Cameroon)
English (Ghana)
English (Nigeria)
English (South Africa)

Figure 2-6. Second Ubuntu Configure the keyboard screen

12



Chapter 2. Installing ClearCount software

10. Inthe third Configure the keyboard screen, accept the default, English
(US), by pressing Enter.

Machine View Devices Help

1

Please select the layout matching the keyboard for this machine.

Keyboard layout:

'
English (US) - Cherokee .
English (US) English (Colemak)

English (US) sh (Dvorak alternative international no dead
English (US) J (Dvorak international with dead keys)
English (US) glish (Dvorak)

English (US) English (Macintosh)

English (US) - English (US, alternative international)

English (US) English (US, international with dead keys)
gEnglish (US) English (US, with euro on 5)

English (US) English (classic Dvorak)

English (US) English (international AlLtGr dead keys)

English (US) English (layout toggle on multiply/divide key)
English (US) English (left handed Dvorak)

English (US) English (programmer Dvorak)

English (US) English (right handed Dvorak)

English (US) Russian (US, phonetic)

<Go Back

Figure 2-7. Third Ubuntu Configure the keyboard screen

13



2.1 Installing ClearCount

11. (If applicable) In the Configure the network screen, select the network

port you want to use and press Enter.

. The installation wizard skips this screen if the computer has only

one network port.

s the net

1 L) X

Your system has multiple network interfaces. Choose the one to use as
the primary network interface during the installation. If possible,
the first connected network interface found has been selected.

Primary network interface:

M

<Go Back>

ethi: Intel Corporation 82S40EM Gigabit Ethe

Figure 2-8. First Ubuntu Configure the network screen

14



Chapter 2. Installing ClearCount software

12. Obtain the router IP address used by the computer.
a. Open a command window:
On a Windows 7 system
Click Start > All Programs > Accessories > Command Prompt.
On a Windows 8.1 Pro system

From the Start page, select Apps > Windows System > Command
Prompt.

b. At the command prompt, type ipconfig and press Enter.

The Windows IP Configuration appears.
c. Note the value of Default Gateway, which is the router IP address.

d. (Recommended) Record the router IP address on the ClearCount
installation checklist on page 144.

. To troubleshoot router problems, please consult the model-
specific commercial documentation for the router. Note that
Clear Ballot does not recommend setting the router IP address.

15



2.1 Installing ClearCount

13. Inthe next (or first) Configure the network screen, enter the server IP
address and press Enter.

. The first three sections of the server’s IP address, separated by

periods, must match those used by your router. The fourth
section can be any unused number; Clear Ballot recommends
250. For example, if the router IP address is 192.168.1.1, use
192.168.1.250 for the server IP address.

gure the network [
The IP address is unique to uour computer and is either:

* Four numbers separated by periods; or

x Blocks of hexadecimal characters separated by colons (IPv6).

You can also optionally specify a CIDR netmask.

If you don't know what to use here, consult your network
administrator.

IP address:

<Go Back> <Cont inue>

Figure 2-9. Second Ubuntu Configure the network screen

14. (Recommended) Record the server IP address on the ClearCount installation
checklist on page 144.

16



Chapter 2. Installing ClearCount software

15. Inthe next Configure the network screen, enter the router IP address and
press Enter.

Machine View Devices Help

. | nf

The gateway is an IP address (four numbers separated by periods) that
indicates the gateway router, also known as the default router. All
traffic that goes outside your LAN (for instance, to the Internet) is
sent through this router. In rare circumstances, you may have no
router; in that case, you can leave this blank. If you don't know
the proper answer to this question, consult your network
administrator.

Gateway:

Cont inue>

Figure 2-10. Third Ubuntu Configure the network screen

16. Inthe next Configure the network screen, reenter the router IP address
and press Enter.

Machine View Devices Help

{ (1] Configure the netuo

The name servers are used to look up host names on the network.
Please enter the IP addr s (not host names) of up to 3 name
servers, separated by spaces. Do not use conmas. The first name
server in the list will be the first to be queried. If you don’'t want
to use any name server, just leave this field blank.

Name server addresses:

<Go Back> ¢Cont inue>

Figure 2-11. Fourth Ubuntu Configure the network screen

17



2.1 Installing ClearCount

17. Inthe final Configure the network screen, enter the hostname and press
Enter.

. The hostname identifies the ScanServer computer, and is used

in web browsers for navigating to the server. Clear Ballot
recommends accepting the default hostname, ScanServer, but
you can use another name.

Machine View Devices Help

{ n¥ lgure the

Please enter the hostname for this system.

The hostname is a single word that identifles your system to the
network. If you don't know what your hostname should be, consult your
network administrator. If you are setting up your own home network,
you can make something up here.

Hostname:

Cont inue>

Figure 2-12. Fifth Ubuntu Configure the network screen

18. (Recommended) Record the hostname on the ClearCount installation
checklist on page 144.

18



Chapter 2. Installing ClearCount software

19. Inthe first Set up users and passwords screen, accept Linux
administrator, the default full user name for the administrator of the local
Linux account, by pressing Enter.

. ClearCount records all logins for this account. Log in and use this
account only if instructed to do so by Clear Ballot Technical
Support. It is not for normal electoral duties.

] [11] Set up users and passwords |

A user account will be created for you to use instead of the root
account for non-administrative activities.

Please enter the real name of this user. This information will be
used for instance as default origin for emails sent by this user as
well as any program which displays or uses the user's real name. Your
full name is a reasonable choice.

Full name for the new user:

<Go Back> <Cont inue>

Figure 2-13. First Ubuntu Set up users and passwords screen

20. Inthe second Set up users and passwords screen, enter the user name
for logging in to the Linux account and press Enter.

{ [11] Set up users and passwords F
Select a username for the new account. Your first name is a
reasonable choice. The username should start with a lower-case
letter, which can be followed by any combination of numbers and more
lower-case letters.

Username for your account:

<Go Back> <Cont inue>

Figure 2-14. Second Ubuntu Set up users and passwords screen

21. (Recommended) Record the Linux user name on the ClearCount installation
checklist on page 144.
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2.1 Installing ClearCount

22.

23.

24,

25.

In the third Set up users and passwords screen, enter the password for
logging in to the Linux account and press Enter.

. All passwords must satisfy the rules, and should meet the
guidelines, provided in ClearCount Election Administrator's
Guide.
I ot o s o paerds |

A good password will contain a mixture of letters, numbers and
punctuat lon and should be changed at regular intervals.

Choose a password for the new user:

Go Back> Cont inue

Figure 2-15. Third Ubuntu Set up users and passwords screen

In the fourth Set up users and passwords screen, reenter the password
for the Linux account and press Enter.
{ [11] set up users and passwords |

Please enter the same user password again to verify you have typed it
correctly.

Re-enter password to verify:

G0 Back Cont inue

Figure 2-16. Fourth Ubuntu Set up users and passwords screen

(If applicable) If the following screen appears, press Tab to advance to
<Yes>, press Enter, select Set up users and passwords from the menu
of installation steps, and reenter all account settings for the Linux
administrator.

{ [11] Set up users and passwords |

You entered a password that consists of less than eight characters, which is considered
too weak. You should choose a stronger password.

Use weak password?

<Go Back> <Yes>

Figure 2-17. Fifth Ubuntu Set up users and passwords screen

. The installation wizard skips this screen if password length is at
least eight characters.

(Recommended) Record the Linux password on the ClearCount installation
checklist on page 144.
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Chapter 2. Installing ClearCount software

26. Inthe Configure the clock screen, confirm your time zone and then press
Enter.

I 1] Configure the clock F

Based on your present physical location, your time zone is America/New_York.
If this is not correct, you may select from a full list of time zones instead.

Is this time zone correct?

{Go Back> <No>

Figure 2-18. Ubuntu Configure the clock screen

27. In the first Partition disks screen, accept the default, Guided - use
entire disk and set up LVM, and press Enter. (LVM stands for Logical
Volume Manager, which is a flexible method of disk space allocation.)

. The installation procedure is about to overwrite the existing
operating system on the ScanServer computer with the Ubuntu
Linux operating system. All data residing on the computer

becomes irretrievable at this point, even if you return to prior
steps in the procedure (using <Go Back>). You must ensure
data residing on the computer that must be backed up is backed
up. If you have any doubts about continuing, exit the installation
wizard now.

Machine View Devices Help

Part it gisks |

The installer can guide you through partitioning a disk (using
different standard schemes) or, 1f you preter, you can do it
manually. With guided partitioning you will still have a chance later
to review and customise the results,

If you choose guided partitioning for an entire disk, you will next
be asked which disk should be used.

Partitioning method:

Guided - reuse partition, LVM VG ScanServer-vg, LV root
Gu ided entire dis
Guided e partition, LW VG ScanServer-vg, LV root

Guided -
Manual

Go Bac

Figure 2-19. First Ubuntu Partition disks screen
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2.1 Installing ClearCount

28. Inthe second Partition disks screen, select the disk to partition and press
Enter.

. The primary internal hard drive is selected by default. If the
hardware configuration includes more than one drive, do not
select an external drive.

Machine View Dewces Help

1 } Fartitl JISKS |

Note that all data on the disk you select will be erased, but not
before you have confirmed that you really want to make the changes.

Select disk to partition:

Figure 2-20. Second Ubuntu Partition disks screen
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Chapter 2. Installing ClearCount software

29. Inthe third Partition disks screen, press Tab to select Yes and then press
Enter.

1 [!!] Part isks F
The selected device already contains the following LWM logical
volumes, volume groups and physical volumes which are about to be
removed:

Logical volume(s) to be removed: root, swap_1

Volume group(s) to be removed: ScanServer-vg

Physical volume(s) to be removed: /dev/sdaS

Note that this will also permanently erase any data currently on the
logical volumes,

Remove existing logical volume data?

<Go Back>

Figure 2-21. Third Ubuntu Partition disks screen

30. Inthe fourth Partition disks screen, press Tab to select Yes and then
press Enter.

Machine View Devices Help

{ [11] Partition disks F

Before the Logical Volume Manager can be confligured, the current
partitioning scheme has to be written to disk. These changes cannot
be undone.

After the Logical Volume Manager is configured, no additional changes
to the partitioning scheme of disks containing phusical volumes are
allowed during the installation. Please decide if you are satisfied
with the current partitioning scheme before continuing.

The partition tables of the following devices are changed:
(sda)

The following partitions are golng to be formatted:
partition #1 of SCSI3 (0,0,0) (sda) as ext2

Write the changes to disks and configure LW?

Figure 2-22. Fourth Ubuntu Partition disks screen
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2.1 Installing ClearCount

31. Inthe fifth Partition disks screen, accept the default amount of the volume
group for the primary partition by pressing Enter.

1

You may use the whole volume group for guided partitioning, or part
of it. If you use only part of it, or if you add more disks later,
then you will be able to grow logical volumes later using the LW

tools, so0 using a smaller part of the volume group at installation
time may offer more flexibility.

The minimum size of the selected partitioning recipe is 1.6 GB (or
14%); please note that the packages you choose to install may require
more space than this. The maximum avallable size is 11.0 GB.

Hint: “max” can be used as a shortcut to specify the maximum size, or
enter a percentage (e.g. "20%") to use that percentage of the maximum
size.

Amount of volume group to use for guided partitioning:

<Continue>

Figure 2-23. Fifth Ubuntu Partition disks screen

32. Inthe sixth Partition disks screen, use the Tab key to select Yes to
confirm the disk changes, and then press Enter.

Machine

View Devices Help

1 ks F

If you continue, the changes listed below will be written to the
disks. Otherwise, you will be able to make further changes manually.

WARNING: This will destroy all data on any partitions you have
removed as well as on the partitions that are going to be formatted.

The partition tables of the following devices are changed:
LW VG ScanServer-vg, LV root
LW VG ScanServer-vg, LV susp_1

The following partitions are going to be formatted:
LW VG ScanServer-vg, LV root as extd
LW VG ScanServer-vg, LV swap_1 as swap
partition #1 of SCSI3 (0,0,0) (sda) as ext2

Write the changes to disks?

Figure 2-24. Sixth Ubuntu Partition disks screen

The system now installs a number of files. This may take several

. minutes.
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Chapter 2. Installing ClearCount software

33. Inthe first Configuring mysql-server-5.5 screen, enter a password for the
MySQL database root user and press Enter.

. All passwords must satisfy the rules, and should meet the

guidelines, provided in ClearCount Election Administrator's
Guide.

. ClearCount records all logins for this account. Log in and use this
account only if instructed to do so by Clear Ballot Technical

Support. It is not for normal electoral duties.

While not mandatory, it is highly recommended that

you set a password
for the MySQL administrative “root” user.

If this field is left blank, the password will not be changed.
New password for the MuSQL “root' user:

Cont inue

< >

Figure 2-25. First Ubuntu Configuring mysql server screen

34. Inthe second Configuring mysql-server-5.5 screen, reenter the
password for the database root user and press Enter.

Machine View Devices Help

11

Repeat password for the MySQL "root' user:

Retrieving fi

Cont fnue>

< >

Figure 2-26. Second Ubuntu Configuring mysql server screen
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2.1 Installing ClearCount

35. (Recommended) Record the database root user password on the ClearCount
installation checklist on page 144.

36. In the first Configuring clearballot screen, enter the user name for the
first administrative account and press Enter.

. ClearCount records all logins for this account. Clear Ballot
recommends using an easily distinguishable name, such as the

actual name of the user, to facilitate tracking the user.

———| Create a Clear Ballot web account for the Initial administrator.

I | Enter & usernane for the first Clear Ballot ueb administrative account:

Retrievi

<Cont inue>

Figure 2-27. First Ubuntu Configuring clearballot screen

37. (Recommended) Record the user name for the first administrative account
on the ClearCount installation checklist on page 144.
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Chapter 2. Installing ClearCount software

38. Inthe second Configuring clearballot screen, enter the password for the
first administrative account and press Enter.

. All passwords must satisfy the rules, and should meet the
guidelines, provided in ClearCount Election Administrator's
Guide.

Create a Clear Ballot wed account for the Lnltlal adminlstrator,

Enter a password for the flrst Clear Ballot web adminlstratlve account:

<Cont Lnue>

Figure 2-28. Second Ubuntu Configuring clearballot screen

39. (Recommended) Record the password for the first administrative account on
the ClearCount installation checklist on page 144.
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40.

41.

42.

43.

44,

In the third Configuring clearballot screen, enter the password for the
ScanStation account. This account protects Tabulator access. You enter this
password on each ScanStation computer when Tabulator is launched to
ensure tabulation is authentic. Press Enter.

. All passwords must satisfy the rules, and should meet the
guidelines, provided in ClearCount Election Administrator's
Guide.

Create a Clear Ballot 'ScanStation' account that protects Tabulator access.

Enter a passuord for the Clese Ballot 'ScanStation’ account:

<acont ires

Figure 2-29. Third Ubuntu Configuring clearballot screen

(Recommended) Record the password for the ScanStation account on the
ClearCount installation checklist on page 144.

Wait for up to 30 minutes as software is installed.

. Do not unplug, close, or shut down the computer while you are
waiting. Also do not eject the ClearCount DVD.

Upon completion, the following screen appears:

T nish tt et > ion
1 A e Insta I

:f 'H,_l}'_ f ll}:l_r""
Installation is complete, so it is time to boot into your new system,
Make sure to remove the installation media (CD-RON, flopples), so
that you boot Into the new system rather than restarting the
installatjon.

<Go Back>

Figure 2-30. Ubuntu Finish the installation screen

Remove and secure the ClearCount DVD.
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Chapter 2. Installing ClearCount software

45. Reboot the computer.
The Ubuntu login screen appears on restart, indicating that the ScanServer

is running and available.

Figure 2-31. Ubuntu login screen

Do not log in as Linux administrator at this time. In the event of
anissue, only log in as Linux administrator under the direction of

Clear Ballot Technical Support.

For information on setting up and connecting ScanStations to the ScanServer, see
Configuring ScanStations on page 33. To perform pre-election administrative
tasks such as creating elections and users, see Creating elections and users on

page 131.
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2.2 Restricting access to BIOS on the ScanServer

2.2 Restricting access to BIOS on the ScanServer

Access to BIOS is restricted by implementing a supervisory password. The
following procedure for hardening Toshiba Satellite L855 computers is an example
of how to do this. The behavior of BIOS depends upon computer make and model;
consult your computer’s documentation or contact Clear Ballot service personnel

for details.

Configuring Toshiba Satellite L855 computers

To restrict access to BIOS on a Toshiba Satellite L855 computer:

1. Shut down the ScanServer computer as follows:

On a Windows 7 system

Shut down the computer normally.

On a Windows 8.1 Pro system

Depress the Shift key while shutting down the computer.

2. Depress the F2 key while starting up the computer.

The BIOS manager appears upon startup.

3. Set the BIOS password:

a.
b.
C.
d.

€.

Navigate to the Security tab using the arrow keys.
Navigate to the Supervisor password using the arrow keys.
Press Enter.

Enter and confirm the password.

Record the BIOS password on the ClearCount installation checklist on
page 144,

4. Disable access to the Boot menu:

a.
b.

C.

Navigate to the Security tab using the arrow keys.
Select Boot Menu using the arrow keys.

Press Enter.

. Select Disabled.
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Chapter 2. Installing ClearCount software

5. Set boot order:
a. Navigate to the Boot tab using the arrow keys.

b. Select HDD/SSD using the arrow keys.
Cc. Press F6 key until HDD/SSD is in position 1.

6. Press F10.
The Exit Saving Changes prompt appears.

7. Ensure Yes is selected and press Enter.

The computer reboots.
8. Turn the computer off and on.

9. Verify the changes.

2.3 Updating ClearCount

Updated ClearCount software is installed over the previous version. There is no
need to uninstall the previous version.

. Reinstalling ClearCount erases any election databases currently
residing on the ScanServer. Ensure databases are archived before
installing the upgrade. See ClearCount Election Administrator's Guide,
Backing up an election for instructions.

To update ClearCount software on the ScanServer, it is necessary to temporarily
change BIOS setup to permit booting from the DVD drive. The following procedure
for reinstalling the software on Toshiba Satellite L855 computers is an example of
how to do this. The behavior of BIOS depends upon computer make and model;
consult your computer’s documentation or contact Clear Ballot service personnel
for details.

Updating ClearCount on Toshiba Satellite L855 computers
Do as follows:
1. Shut down the ScanStation computer as follows:
On a Windows 7 system

Shut down the computer normally.
On a Windows 8.1 Pro system

Depress the Shift key while shutting down the computer.
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2.3 Updating ClearCount

10.

Depress the F2 key while starting up the computer.
The BIOS manager appears upon startup.

Enter the BIOS password. (See Restricting access to BIOS on the
ScanServer on page 30.)

Enable access to the Boot menu:

a. Navigate to the Security tab using the arrow keys.
b. Select Boot Menu using the arrow keys.
Cc. Press Enter.
d. Select Enabled.
This allows you to boot from the DVD drive.

Press F10.
The Exit Saving Changes prompt appears.

Ensure Yes is selected and press Enter.

The computer reboots.

Turn the computer off and on.

Verify the changes.

Reinstall the ClearCount software. (See Installing ClearCount on page 9.)

Disable access to the Boot menu with reference to steps 1-9 of this
procedure.
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Chapter 3. Configuring ScanStations

After installing the ClearCount software on the ScanServer, which you did following
the instructions in Chapter 2, you must install and configure scanner software on
the ScanStation computers. The following steps must be performed in the
specified order on each ScanStation:

1. Create a restore point.

Restrict access to BIOS.

Remove extraneous programs.

Disable wireless Internet access.

Install ScandAll PRO™.

Install the TWAIN driver.

Map the ScanStation to the ScanServer.

Create a desktop shortcut to the P: drive.

W ® N o U kR W N

Configure the scanner as a device.

=
©

Run the scanner update script.

=
=

Configure ScandAll PRO.

[
N

. Test the scanner cameras.

[T
[6V)

. Set Windows passwords.

=
N

. View the Windows Event Log.

[y
ul

. Update Windows Defender definitions.

[
(o)}

. Restrict program access and add application whitelists.

=
N

. Deny access to USB drives.

[y
o8}

. Power down and restart all ScanStation computers.

=
O

. Validate software setup.

N
o

. Test the ScanStation configuration.

N
=

. Prepare for daily scanning.
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Chapter 3. Configuring ScanStations

. To maintain ScanStation security, the passwords for the Windows
computers as well as the password for Tabulator should be known

only to election officials or supervisors with appropriate privileges.
These passwords cannot be shared with ScanStation operators.
Likewise, ScanStation operators should not be given access to the
DeleteBox utility. If a ScanStation operator needs to restart a process
or correct an error, they should consult with the supervisor who enters
the required passwords.

. After completing the steps in this chapter and before first use, you
must review and implement the hardening steps for all ScanStations
specified in Hardening, validating, and securing the system on
page 101.

3.1 Creating a restore point

Creating a restore point before making configuration changes to any ScanStation
enables rolling back to the state that existed before the changes were made.

. If you want, you can create intermediate restore points at any time in
the process.

To create the restore point:

1. Login to the ScanStation computer as a Windows administrator.

2. Do as follows:
On a Windows 7 system

a. From the Windows Start menu, search for Restore point.
b. From the top of the Start menu, select Create a restore point.

On a Windows 8.1 Pro system

a. From the Start page, search for restore.
b. From the search results, select Create a restore point.
The System Properties dialog appears.
3. (If necessary) Select the System Protection tab.
4. Click Create.

The Create a restore point dialog appears.

5. Enter a descriptive name for the restore point using this format:
yyyy-mm-dd--hh-mm-ss_Before_Clear_Ballot_configuration
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3.2 Restricting access to BIOS on ScanStations

3.2

Click Create.

The restore point is created in a minute or two. Then the System
Protection message box displays the message The restore point was
created successfully.

Click Close to dismiss the message.

Click OK to dismiss the Create a restore point dialog.

Restricting access to BIOS on ScanStations

Access to BIOS is restricted by implementing a supervisory password. The
following procedure for hardening Toshiba Satellite L855 computers is an example
of how to do this. The behavior of BIOS depends upon computer make and model;
consult your computer’s documentation or contact Clear Ballot service personnel
for details.

Configuring Toshiba Satellite L855 computers

To restrict access to BIOS on a Toshiba Satellite L855 computer:

1. Shut down the ScanStation computer as follows:

On a Windows 7 system
Shut down the computer normally.
On a Windows 8.1 Pro system

Depress the Shift key while shutting down the computer.

Depress the F2 key while starting up the computer.
The BIOS manager appears upon startup.

3. Setthe BIOS password:

a. Navigate to the Security tab using the arrow keys.

b. Navigate to the Supervisor password using the arrow keys.
Cc. Press Enter.

d. Enter and confirm the password.

e. Record the BIOS password on the ClearCount installation checklist on
page 144.
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4. Disable access to the Boot menu:

3.3

a. Navigate to the Security tab using the arrow keys.
b. Select Boot Menu using the arrow keys.

Cc. Press Enter.

d. Select Disabled.

Set boot order:

a. Navigate to the Boot tab using the arrow keys.
b. Select HDD/SSD using the arrow keys.
c. Press F6 key until HDD/SSD is in position 1.

Press F10.
The Exit Saving Changes prompt appears.

Ensure Yes is selected and press Enter.

The computer reboots.
Turn the computer off and on.

Verify the changes.

Removing extraneous programs

Uninstall any extraneous third-party programs that the manufacturer may have
installed on any Windows computers to be used in the ClearCount system. These
include programs of various types, including temporary subscriptions to third-
party antivirus software.

On a Windows 7 system

To remove unwanted programs from a Windows 8.1 Pro system:

1.
2.

From the Windows Start menu, select Control Panel.

In the Adjust your computer’s settings screen, in the Programs area,
click Uninstall a program.

Click the program you want to remove to select it, and then click Uninstall.
Follow any uninstall instructions that appear for that specific program.

Repeat step 3 for each program you want to uninstall.

Close the Control Panel.
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On a Windows 8.1 Pro system
To remove unwanted programs from a Windows 8.1 Pro system:
1. From the Start page, search for control.

2. From the search results, select Control Panel.

3. Inthe Adjust your computer’'s settings screen, click Programs and
Features.

4. Click the program you want to remove to select it, and then click Uninstall.
Follow any uninstall instructions that appear for that specific program.

5. Repeat step 3 for each program you want to uninstall.

6. Close the Control Panel.

3.4 Disabling wireless Internet access

You must permanently disable the wireless network card on any computer being
used in the ClearCount system. The details on how to do this may vary depending
upon the make and model of computer, but typically it consists of disabling the
network adapter in the Windows Device Manager and then turning off the WLAN
AutoConfig service in Administrative Tools > Services. For more information,
consult your hardware documentation.

3.5 Installing ScandAll PRO

ScandAll PRO, the Fujitsu image-scanning software, is described in these
documents:

Table 3-1. ScandAll PRO documentation

ScandAll PRO v2.x Readme pro-v2-readme.pdf
ScandAll PRO V2.0 User’s Guide P2WW-2860-03enzo.pdf

To install ScandAll Pro:
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Chapter 3. Configuring ScanStations

1. Log into the ScanStation computer as the Windows administrator.

2. Load the provided ScanStation software DVD.
DVD contents appear in the right pane of the Explorer window.

fi-6670_driver
fi-6800_driver
fi-7180_driver
Scandall Pro 2.0.12 Update
ScandAll_Pro

Figure 3-1. Contents of ScanStation software DVD

3. Double-click the ScandAll_Pro folder.
Folder contents appear in the right pane of the Explorer window.

KL
. SDATAI1
SDATA2
Tools
19 ScandAlIPRO
3 ScandAIIPROSH

Figure 3-2. Contents of ScandAll_Pro folder

4. Double-click the ScandAIIPRO executable.

The User Access Control dialog appears (Do you want to allow the
following program to make changes to this computer?).
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3.5 Installing ScandAll PRO

5. Click Yes.
The language selection dialog for the installation procedure appears.

Fujitsu ScandAll PRO

Please select the language used by this installation from the
following list.

English v
¥| Install ScandAll PRO
[ ]Install Scan to Microsoft SharePoint.
oK

Figure 3-3. Language selection dialog

. Do not select Install Scan to Microsoft SharePoint.

6. Click OK.
The ScandAll PRO V2.0.1 Setup Wizard opens at the Welcome screen.

Welcome to the Fujitsu ScandAll PRO
V2.0.1 Setup Wizard

The Setup Wizard will instal Fuitsu ScandAll PRO V2.0.10n
your computer. Chick Next 1o continue or Cancal to exit the
Setup Wizard

Figure 3-4. ScandAll PRO V2.0.1 Setup Wizard, Welcome screen
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7. Click Next.
The End-User License Agreement screen appears.

Please read the following icensa agreament carefully

END-USER LICENSE AGREEMENT
FOR Fujitsu ScandAll PRO

This End-User License Agreement ("EULA") is a legal agreement between
the onginal purchaser of this software or the purchaser’s assignee and PFU

LIMITED ("PFU") for the PFU software known as the ScandAll PRO., including
the iated media ("Softy ")

BY INSTALLING, COPYING. OR USING THIS SOFTWARE, YOU AGREE TO

BE BOUND BY THE TERMS OF THIS EULA IF YOU DO NOT AGREE TO

THE TERMS OF THIS EULA. DO NOT INSTALL. COPY. OR USE THE
SOFTWARE: YOU MAY RETURN IT TO YOUR PLACE OF PURCHASE FORA v

[W] 1 acoept the terms in the Licanse Agreement

Figure 3-5. ScandAll PRO V2.0.1 Setup Wizard, End-User License Agreement
screen

8. SelectI accept the terms of the License Agreement and click Next.
The Product Description screen appears.

Product Description
Reaad the following description about the product.

Fujitsu ScandAll PROV2.0.1
README

Copyright PFU LIMITED 2007-2011

This file contains information about things you should know before using this
product as well as the |atest information, which is not included in Online Help

topecs.
Be sure to read this file prior to use

Figure 3-6. ScandAll PRO V2.0.1 Setup Wizard, Product Description screen
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3.5 Installing ScandAll PRO

9. Peruse the Readme and click Next.
The Destination Folder screen appears.

Cick Neat to install to the defauk folder or cick Browse to choose ancther.

Folder name:

|C:\Program Fles (<86)\iScanner\ScandAl PRO\

Figure 3-7. ScandAll PRO V2.0.1 Setup Wizard, Destination Folder screen

10. Click Next.
The Setup type screen appears.

Setup type
Selact one of the following setup types.

(] Place ScandAl PRO shortcut on the desiiop

Figure 3-8. ScandAll PRO V2.0.1 Setup Wizard, Setup type screen

41



Chapter 3. Configuring ScanStations

11. Click Next.
The Ready to install screen appears.

& Fujitsu ScandAll PRO V2.0.1 Setup -

A\A

Ready to install Fujitsu ScandAll PRO V2.0.1 \7{3

—

Cick Install to begin the instalation. Oick Back to review or change any of your installation
settings. Cick Cancel 10 ext the wizard

Install Fujtsu ScandAl PRO V2.0.1t0
C:\Program Fllas (x86)\fiScanner\ScandAl PRO\

Figure 3-9. ScandAll PRO V2.0.1 Setup Wizard, Ready to Install screen

12. Click Install and wait as the installation progresses.

The Completed screen appears.

Completed the Fujitsu ScandAll PRO
V2.0.1 Setup Wizard

Qick the Finish button to ext the Setup Wizard

Figure 3-10. ScandAll PRO V2.0.1 Setup Wizard, Completed screen
13. Click Finish.

14. Browse back to the top-level folder of the ScanStation software DVD.
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15. Double-click the ScandAll Pro 2.0.12 Update folder.
Folder contents appear in the right pane of the Explorer window.
| SDATAI1
| SDATA2

. Tools
"Ly ScandAlIPRO

Figure 3-11. Contents of ScandAll Pro V2.0.12 Update folder

16. Double-click the ScandAIlIPRO executable.
The User Access Control dialog reappears (see step 4).

17. Click OK.
The ScandAll PRO V2.0.12 Setup Wizard opens at the Welcome screen.

Welcome to the Fujitsu ScandAll PRO
V2.0.12 Setup Wizard

The Setup Wizard wil instal Futsu ScandAl PROV20.120n
your computer. Click Neat to continue or Cancel to et the
Setup Wizard

Figure 3-12. ScandAll PRO V2.0.12 Setup Wizard, Welcome screen
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18. Click Next.
The End-User License Agreement screen appears.

Please read the following icensa agreament carefully

END-USER LICENSE AGREEMENT
FOR ScandAll PRO

Thank you for purchasing the the PFU fi senes scanner product ("Product’).
This EULA is a licanse agreement between You and PFU LIMITED (PFU")
governing the use of the ScandAll PRO ("Software”), which is to be used with

the Product .

BY USING THE PRODUCT, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS EULA. IF YOU DO NOT AGREE TO THE TERMS OF THIS EULA, YOU
IARE NOT PERMITTED TO USE THE PRODUCT. YOU REPRESENT THAT
[YOU ARE ACTING ON BEHALF OF YOUR EMPLOYER AND ARE

[]1acoept the temms in the Licanse Agreement

Figure 3-13. ScandAll PRO V2.0.12 Setup Wizard, End-User License Agreement
screen

19. Select I accept the terms of the License Agreement and click Next.

The Product Description screen appears.

Product Description
Reaad the following description about the product.

Fujitsu ScandAll PRO V2.0.12
README

Copyright PFU LIMITED 2007-2013

This file contains information about things you should know before using this
product as well as the |atest information, which is not included in Online Help

topecs.
Be sure to read this file prior to use

Figure 3-14. ScandAll PRO V2.0.12 Setup Wizard, Product Description screen
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20. Peruse the Readme and click Next.
The Ready to install screen appears.

Ready to install Fujitsu ScandAll PRO V2.0.12

Cick Install to begin the installation. Cick Back to review or change any of your installation
settings. Cick Cancel 10 &t the wizard

Install Fujtsu ScandAl PRO V2.0.12t0
C:\Program Fllas (x86)\fiScanner\ScandAl PRO\

Figure 3-15. ScandAll PRO V2.0.12 Setup Wizard, Ready to Install screen

21. Click Install and wait as the installation progresses.

The Completed screen appears.

Completed the Fujitsu ScandAll PRO
V2.0.12 Setup Wizard

Cick the Finish button to ext the Setup Wizard

Figure 3-16. ScandAll PRO V2.0.12 Setup Wizard, Completed screen
22. Click Finish.

23. Remove and secure the ScanStation software DVD.
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3.6 Installing the Fujitsu TWAIN driver

A Fujitsu scanner model-specific TWAIN driver is required for communication
between the ScanStation computer and the scanner. Choices include:

. fi-6670
. fi-6800
« fi-7180
. The choice of driver required depends on the scanner model in use.

Exactly one Fujitsu TWAIN driver can be installed at a time on any
ScanStation computer.

3.6.1 Installing the Fujitsu fi-6670 TWAIN driver

To install the Fujitsu fi-6670 TWAIN driver:

1. Ensure the scanneris turned off.

2. Loginto the ScanStation computer as the Windows administrator.
3. (If necessary) Uninstall the current TWAIN driver.
4

. Load the provided ScanStation software DVD.
DVD contents appear in the right pane of the Explorer window.

fi-6670_driver
fi-6800_driver
fi-7180_driver
Scandall Pro 2.0.12 Update
ScandAll_Pro

Figure 3-17. Contents of ScanStation software DVD

5. Browse to the location of the setup program. The path is fi_6670_driver >
TWAIN > 98MEZKXP.
6. Double-click the Setup executable.

The User Access Control dialog appears (Do you want to allow the
following program to make changes to this computer?).
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3.6 Installing the Fujitsu TWAIN driver

7. Click Yes.
The Image Processing Software Option dialog appears.

@ Do you want to install Image Processing Software Option before
installing the scanner driver?

Installing the Image Processing Software Option allows you to produce
far more sharp monochrome outputs.

e ]

Figure 3-18. Image Processing Software Option dialog

8. Click No.

The Scanner Utility for Microsoft Windows InstallShield Wizard
opens at the Choose Setup Language screen.

Cho Setup L
Selact the language for the installation from the choices below.

Figure 3-19. Scanner Utility setup, Choose Setup Language screen
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9. Click Next.
The Welcome screen appears.

Scanner Utility for Microsoft Windows Setup

‘Welcome to the InstaliShield Wizard for Scanner
Utility for Microsoft Windows

The InstalShield Wizaed will nstall Scanner Uty for
Microsolt Wirdows on your computer. To continue, click
Next

Back Next > Cancel

Figure 3-20. Scanner Utility setup, Welcome screen

10. Click Next.
The Information screen appears.

Information
Flaase read the lolowing ted.

Please scroll and be sure 1o tead the ramaining pottion of a tesd

TWAIN Data source Softwace
< 32:0% version >
README File
14, Macch 2012
Veesion 9.21.1202

Copynght PFU LIMITED 19852012

Please read this fle befoee using this product. The fle inchudes
<

< Back Nest> | Cancel

Figure 3-21. Scanner Utility setup, Information screen (fi-6670)
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3.6 Installing the Fujitsu TWAIN driver

11. Peruse the README file in the scrolling window and click Next.
The License Agreement screen appears.

License Agreement
Flaase raad the lollowing bcense agreament cacelully,

Press tha PAGE DOWN key to sea the rest of the agreement.

|PLEASE READ THE FOLLOWING TERMS AND CONDITIONS BEFORE YOU USE

THIS SOFTWARE. YOUR SELECTION OF “Yes" BUTTON INDICATES YOUR

I&JRSF'}SJNMSJDING AND ACCEPTANCE OF ALL OF THE FOLLOWING TERMS AND
ITH

1. LICENSE AND COPYRIGHTS

‘You may use the Soltwate sclely on & single computer ot & tme. For the avoidance of
doubt, you acquire only a kmited nght to use the Software hereunder, and FUNITSU o ary
hdp«tydevdapulmdm: nchuding but not kmted to copynights, in and to the v

Do you accept all the terms of the preceding Licente Agreement? I you Pint
select No, the setup wall close. To install Scanner Utiity for Microsoft
Windows, you must accept thes agreement.

< Back Yes

Figure 3-22. Scanner Utility setup, License Agreement screen

12. Click Yes.
The Choose Destination Location screen appears.

Choose Destination Location
Selact lolder where setup wil nstal fles.

Setup will install Scanner Uty for Mictosolt Windows in the following folder.

To install to thes folder, chck Next. To instal 1o a different folder, cick Biowse and sedect
anothes folder,

Figure 3-23. Scanner Utility setup, Choose Destination Location screen
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13. Click Next.
The Select Features screen appears.
Scanner Utility for Microsoft Windows Setup

Select Features \\.
Selact the lestures satup will install

Selact the features pou want to nstal, and deselect the featues pou do not wank 1o install

2 TWAIN Driver 26680 K Descrption
v TWAIN Manager MK This component contains the
¥ 5 t Tools 163K TWAIN-DataSource, the
V) Suppor driver which is unique for this
device, and compression and
a fle for the fle transfer.
Change
Space Requeed on C: 2K
Space Avadable on C: 330501564 K
< Back Nead > Cancel

Figure 3-24. Scanner Utility setup, Select Features screen

14. Ensure TWAIN Driver, TWAIN Manager, and Support Tools are
selected, and click Next.

. The space requirements should be non-zero. If they are not,
another TWAIN driver is installed and must be uninstalled.

The Select Program Folder screen appears.

Select Program Folder
Flaase select a peogram folder,

Setup wil add program icons to the Program Folder ksted below. 'You may type a new folder
name, of sedect ane from the exsting folders kst. Chck Neat to contirue.

f’togam Folder:
cannes Uty for Miciosoft Windows

Em Folders:
Fuptsu Scanddll FRO

Microsoft Office 2013
MySaL
Oracle VM VitusBox
| Scanned Utiity for Micsosoft Windows

Figure 3-25. Scanner Utility setup, Select Program Folder screen
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15. Click Next.
The Start Copying Files screen appears.

Start Copying Files
Review settings befote copying fles.

Setup has enough infoemation o start copying the program fles. If you want to review of
change any settings, chick Back. If you are satishied with the settings, ciick Neat to begn
copying fles.
Current Settings:
Uset Indormation:
FUJITSU SCANNER USER
S00000001

455-130404401

Target Direclony:
C:\Program Files (BE/\fwan

Program Folder.
Scanner Utity for Micsosoft Windows

Figure 3-26. Scanner Utility setup, Start Copying Files screen
16. Click Next.

The Setup Status screen appears; it has an active progress bar that flashes
green as installation proceeds. After several minutes, the InstallShield
Wizard Complete screen appears.

InstallShield Wizard Complete

The setup installad Scarner Utlity for Microsoft Windows n
the computer normally Beloce using this program, it is necessaty
o 1e-stant & computer.

(@) Yes, | wank to restart ey computer now.

(O No. | wall restant my compuber lates,

Please chck [Finish] button and end an setup

Figure 3-27. Scanner Utility setup, InstallShield Wizard Complete screen
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17.

18.

Ensure Yes, I want to restart my computer now is selected and click
Finish.
The computer shuts down and restarts.

Remove and secure the ScanStation software DVD.

3.6.2 Installing the Fujitsu fi-6800 TWAIN driver

To install the Fujitsu fi-6800 TWAIN driver:

1.

2
3.
4

Ensure the scanner is turned off.

. Log into the ScanStation computer as the Windows administrator.

(If necessary) Uninstall the current TWAIN driver.

. Load the provided ScanStation software DVD.

DVD contents appear in the right pane of the Explorer window.

fi-6670_driver
fi-6800_driver
fi-7180_driver
Scandall Pro 2.0.12 Update
ScandAll_Pro

Figure 3-28. Contents of ScanStation software DVD

Browse to the location of the setup program. The path is fi_6800_driver >
TWAIN > 98MEZKXP.

Double-click the Setup executable.

The User Access Control dialog appears (Do you want to allow the
following program to make changes to this computer?).
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3.6 Installing the Fujitsu TWAIN driver

7. Click Yes.
The Image Processing Software Option dialog appears.

@ Do you want to install Image Processing Software Option before
installing the scanner driver?

Installing the Image Processing Software Option allows you to produce
far more sharp monochrome outputs.

e ]

Figure 3-29. Image Processing Software Option dialog

8. Click No.

The Scanner Utility for Microsoft Windows InstallShield Wizard
opens at the Choose Setup Language screen.

Cho Setup L
Selact the language for the installation from the choices below.

Figure 3-30. Scanner Utility setup, Choose Setup Language screen
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9. Click Next.
The Welcome screen appears.

Scanner Utility for Microsoft Windows Setup

‘Welcome to the InstaliShield Wizard for Scanner
Utility for Microsoft Windows

The InstalShield Wizaed will nstall Scanner Uty for
Microsolt Wirdows on your computer. To continue, click
Next

Back Next > Cancel

Figure 3-31. Scanner Utility setup, Welcome screen

10. Click Next.
The Information screen appears.

Information
Flaase read the lolowing ted.

Please scroll and be sure 1o tead the ramaining pottion of a tesd

TWAIN Data source Softwace
< 32:0% version >
README File
27, June. 2012
Version 10.10.710.0

Copynght PFU LIMITED 19852012

Please read this fle befoee using this product. The fle inchudes
<

< Back Nest> | Cancel

Figure 3-32. Scanner Utility setup, Information screen (fi-6800)
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11. Peruse the README file in the scrolling window and click Next.
The License Agreement screen appears.

License Agreement
Flaase raad the lollowing bcense agreament cacelully,

Press tha PAGE DOWN key to sea the rest of the agreement.

|PLEASE READ THE FOLLOWING TERMS AND CONDITIONS BEFORE YOU USE

THIS SOFTWARE. YOUR SELECTION OF “Yes" BUTTON INDICATES YOUR

I&JRSF'}SJNMSJDING AND ACCEPTANCE OF ALL OF THE FOLLOWING TERMS AND
ITH

1. LICENSE AND COPYRIGHTS

‘You may use the Soltwate sclely on & single computer ot & tme. For the avoidance of
doubt, you acquire only a kmited nght to use the Software hereunder, and FUNITSU o ary
hdp«tydevdapulmdm: nchuding but not kmted to copynights, in and to the v

Do you accept all the terms of the preceding Licente Agreement? I you Pint
select No, the setup wall close. To install Scanner Utiity for Microsoft
Windows, you must accept thes agreement.

< Back Yes

Figure 3-33. Scanner Utility setup, License Agreement screen

12. Click Yes.
The Choose Destination Location screen appears.

Choose Destination Location
Selact lolder where setup wil nstal fles.

Setup will install Scanner Uty for Mictosolt Windows in the following folder.

To install to thes folder, chck Next. To instal 1o a different folder, cick Biowse and sedect
anothes folder,

Figure 3-34. Scanner Utility setup, Choose Destination Location screen
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13. Click Next.
The Select Features screen appears.
Scanner Utility for Microsoft Windows Setup

Select Features \\.
Selact the lestures satup will install

Selact the features pou want to nstal, and deselect the featues pou do not wank 1o install

2 TWAIN Driver 26680 K Descrption
v TWAIN Manager MK This component contains the
¥ 5 t Tools 163K TWAIN-DataSource, the
V) Suppor driver which is unique for this
device, and compression and
a fle for the fle transfer.
Change
Space Requeed on C: 2K
Space Avadable on C: 330501564 K
< Back Nead > Cancel

Figure 3-35. Scanner Utility setup, Select Features screen

14. Ensure TWAIN Driver, TWAIN Manager, and Support Tools are
selected, and click Next.

. The space requirements should be non-zero. If they are not,
another TWAIN driver is installed and must be uninstalled.

The Select Program Folder screen appears.

Select Program Folder
Flaase select a peogram folder,

Setup wil add program icons to the Program Folder ksted below. 'You may type a new folder
name, of sedect ane from the exsting folders kst. Chck Neat to contirue.

f’togam Folder:
cannes Uty for Miciosoft Windows

Em Folders:
Fuptsu Scanddll FRO

Microsoft Office 2013
MySaL
Oracle VM VitusBox
| Scanned Utiity for Micsosoft Windows

Figure 3-36. Scanner Utility setup, Select Program Folder screen
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15. Click Next.
The Start Copying Files screen appears.

Start Copying Files
Review settings befote copying fles.

Setup has enough infoemation o start copying the program fles. If you want to review of
change any settings, chick Back. If you are satishied with the settings, ciick Neat to begn
copying fles.
Current Settings:
Uset Indormation:
FUJITSU SCANNER USER
S00000001

455-130404401

Target Direclony:
C:\Program Files (BE/\fwan

Program Folder.
Scanner Utity for Micsosoft Windows

Figure 3-37. Scanner Utility setup, Start Copying Files screen
16. Click Next.

The Setup Status screen appears; it has an active progress bar that flashes
green as installation proceeds. After several minutes, the InstallShield
Wizard Complete screen appears.

InstallShield Wizard Complete

The setup installad Scarner Utlity for Microsoft Windows n
the computer normally Beloce using this program, it is necessaty
o 1e-stant & computer.

(@) Yes, | wank to restart ey computer now.

(O No. | wall restant my compuber lates,

Please chck [Finish] button and end an setup

Figure 3-38. Scanner Utility setup, InstallShield Wizard Complete screen
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17.

18.

Ensure Yes, I want to restart my computer now is selected and click
Finish.

The computer shuts down and restarts.

Remove and secure the ScanStation software DVD.

3.6.3 Installing the Fujitsu fi-7180 TWAIN driver

To install the Fujitsu fi-7180 TWAIN driver:

1.

2
3.
4

Ensure the scanner is turned off.

. Log into the ScanStation computer as the Windows administrator.

(If necessary) Uninstall the current TWAIN driver.

. Load the provided ScanStation software DVD.

DVD contents appear in the right pane of the Explorer window.

fi-6670_driver
fi-6800_driver
fi-7180_driver
Scandall Pro 2.0.12 Update
ScandAll_Pro

Figure 3-39. Contents of ScanStation software DVD

Browse to the location of the setup program. The path is fi_7180_driver >
02- PSIPTWAIN 1.4.
Double-click the Setup executable.

The User Access Control dialog appears (Do you want to allow the
following program to make changes to this computer?).
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7. Click Yes.
The fi Series Setup utility opens at the Welcome screen.

Software Information

f] Series

PaperSyeam IP Driver 1 4
README Sle

Copynght PFU LIMITED 2013

Thes file includes important notes on ths product and also the addsonal
hormabon not included in the manuals

Table of Contents

1. Migh Sadety Required Use

2 Systern Requwements

3. Notes on Instalaton

4. Notes on Co-estence of Drvers
5. Notes on Preview functon

6. Usage Notes on Asssted Scan
7. Usage Notes for Applcations

8. Notes on Scanney

9. Notes on Scan Setings

10. Other Notes

Next Gncel

Figure 3-40. fi Series Setup utility, Welcome/Software Information screen

8. Peruse the README file in the scrolling window and click Next.
The Select Software screen appears.

fi Series Setup -
Select which software to nstal

2 v PaperStream P (TWAIN)
7 ~ - Scanner Cantral Admin Agent
> Series

Software Description:
AN 20pkcation which centraltes the management of multiple scanners, by ]
alowing you to monkor the cpenating status, check the consumables
repBcement Cydies, receive ermor notfications, and apply module updates and
Change destination:
C\Program Fles (x86)\fScanner Browse...

Requred dek space: —— Drve C:175 M8

Back Next Gncel

Figure 3-41. fi Series Setup utility, Select Software screen
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9. Ensure that PaperStream IP (TWAIN) is selected and that Scanner
Central Admin Agent is not selected, and click Next.

The License Agreement screen appears.

~, Selct Software
f[ Series PaperStream P (TWAIN) v
END-USER LICENSE AGREEMENT ~
AMPORTANT-

PLEASE READ THIS END USER LICENSE AGREEMENT ("EULAY) CAREFULLY
Thes EULA 8 8 legal agreement between You and PFU UMITED (PFU) governeg
e use of the PaperStream IP ("Scltware”). which is 1o be used with the & Senes
scanmer product (Product). THES AGREEMENT IS ENFORCEABLE AGAINST YOU
IAND AGAINST ANY LEGAL ENTITY ON WHOSE BEHALF YOU USE THE PRODUCT
(COLLECTIVELY, “YOU™ AND IN THE POSSESSIVE FORM. “YOUR"). YOU AGREE
THAT YOU HAVE READ AND UNDERSTAND THE TERMS AND CONDITIONS OF
THIS EULA

BY INSTALUING. COPYING. OR USING ANY PART OF THE SOFTWARE. YOU
IAGREE TO BE BOUND BY THE TERMS OF THIS EULA

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THiS EULA. DO
INOT INSTALL, COPY, OR USE THE SOFTWARE IN ANY MANNER

1. Grant of License: Instaliabon and Use

(1) PFU heroby grants You & non-exciusve and non-transferable license 1 possess
and use the Soware in accordance with the Serms and conditons of this EULA. You
agree that You ate hoensng the Solware for Your end use only and not for resale o
rodistritation All Your rights herounder ace subject % and condtioned upon Your
complyng with all of the other terms and condons of thes EULA.

(2) You may nstall and use $he Scltware oo by cne (1) computer at a ime.

9% Vst b mmdmdon, sl = Snd thnm Smmrmn ol e dibimmm b tnin 8 A e

v
¥ 13ccept the terms of kcense agreements for each software to be nstaled

Back ksl | | Cancel

Figure 3-42. fi Series Setup utility, License Agreement screen
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10. Select I accept the terms of license agreements for each software
to be installed and click Next.

The installation screen appears; it has an active progress bar that flashes
green as installation proceeds. Upon successful completion, the progress bar
disappears and the PaperStream IP (TWAIN) and Software Operation Panel
modules are both checked.

Instaled software:

V/ PaperStream 1P (TWAN) ©  1.4.0.2613
Vv Software Operation Panel:  3.7.11.0

The software have been successfuly nstalled.

Frsh

Figure 3-43. fi Series Setup utility, installation screen (on completion)
11. Click Finish.
12. Remove and secure the ScandAll PRO DVD.

3.6.4 Installing the Fujitsu Scanner Error Recovery Guide

Fujitsu distributes an online Error Recovery Guide for each of its scanner
models. A pop-up link to the guide appears whenever a scanner error occurs.
There must be a local copy on each of the ScanStation computers. You must either
install the guide with the scanner driver software, or download it from the Fujitsu
website.

To download the guide:

1. From a computer outside the ClearCount network, browse to
http://www .fujitsu.com/global/support/computing/peripheral/scanners/drivers/.

The fi Series Software Download page appears.
2. Select the tab for your scanner model.

3. Browse the available options to select Error Recovery Guide.
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4. Click Download.

5. Copy the downloaded file to removable media for distribution to ScanStation
computers.

The following figure shows the download site for the Error Recovery Guide for
the fi-6800 scanner:

FUﬁTSU Global Change™® |Searcl
Services (v Products (v Solutions v Fujitsu Cloud v Support [v Corporate Information v

Home > Support & Downloads » Computing Products > Peripherals > FUJITSU Image Scanner > fi Series Software Downloads > Sol

FUJITSU Image Scanner Software Downloads: fi-6800

v fi Senes Software
Downloads Setup Programs Update Client OS Server OS

> fi Senes Manual Downloads

s fi Series FAQ « The following table shows which fi-6800 bundled software are available for download as
complete versions

> ScanSnap Software

Downloads PaperStream IP
> ScanSnap Manual Software Download Release date
Downloads
PaperStream IP (TWAIN) 1.7.0 2846 Download 2/20/2014
> ScanSnap FAQ
PaperStream IP (TWAIN x64) 170 2846 Download 2/20/2014

> ScanSnap Sample .
Scanned Document PaperStream IP (ISIS) 1.7.01403.19001 Dovnload 47172014

» Catalog Downloads @v Recovery Guide V3232 )_ Dovmload 2/20/2014

P

Figure 3-44. Downloading the Fujitsu Scanner Error Recovery Guide

3.7 Mapping the ScanStation to the ScanServer

All of the ClearCount software resides on the ScanServer. It is necessary to
connect each ScanStation to the ScanServer through the router so the necessary
files can be shared. For details, see Setting up the scanning location on page 112.
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3.7 Mapping the ScanStation to the ScanServer

On a Windows 7 system

To map the ScanStation to the ScanServer on a Windows 7 system:
1. Login to the ScanStation computer as the Windows administrator.

2. In Windows Explorer, select the C: drive and click Map network drive.
Organize ~ Properties Systemn properties Uninstall or change a program 7Open Control Panel

& Favorites « Hard Disk Drives (3)

B Desktop Local Disk (C:) Recovery (D:)
i Recent Places  em— =— ] —
&/ 38.4 GB free of 99.7 GB S 168 GB free of 15.2 GE =
8 Downloads
%7 Dropbox < Network Location (1)
2 ScanSnap Folder ~ cbg (\cbgserver2) (P:)
S
G@ Libearies - 3/ 859 GB free of 95.9 GB
2] Documents < Other (1)
o’ Music
W= Pictures
B videos
«3 Homegroup

™ Computer
&4 Local Disk (C)

Figure 3-45. Map network drive selection

3. Inthe Map Network Drive dialog, select the P: drive.

What network folder would you like to map?

Specify the drive letter for the connection and the folder that you want to connect to:

Drive:
Folder: v Browse...
Example: \\server\share
Reconnect at sign-in

[] Connect using different credentials

Connect to a Web site that you can use to store your documents and pictures.

Finish Cancel

Figure 3-46. Map Network Drive dialog

4. Inthe Folder section, click Browse and then browse to the ScanServer
(\\ScanServer_Name\client).

5. Ensure Reconnect at logon is checked.

6. Click Finish.

On a Windows 8.1 Pro system

To map the ScanStation to the ScanServer on a Windows 8.1 Pro system:

63



Chapter 3. Configuring ScanStations

Log in to the ScanStation computer as the Windows administrator.
In the File Explorer, navigate to the top level (This PC).

From the Computer tab, click Map network drive to open the menu, and
then click Map network drive.

RRE - This PC - oIEl
Computer View A o
\ ] @ . ‘. {8 Uninstall or change a program
J w=ul [ - {84 System properties
Properties Open Rename  Accefs Map network d 2 network  Open Control
medide location Panel @ Manage
Locatior
®© (3 ~ 1 ™, ThisPC » v &  SearchThisPC »
~
I Favorites 4 Folders (6)
Bl Desktop

& Downloads . Desktop [~ Documents u Downloads

4 Recent places

). CBGBallotimages | T k - h ™

Figure 3-47. Map network drive selection

Select the P: drive.

What network folder would you like to map?

Specify the drive letter for the connection and the folder that you want to connect to:

Drive: iP: iv

Folder: [ v l [ Browse...
Example: \\server\share
Reconnect at sign-in
[] Connect using different credentials

Connect to 2 Web site that you can use to store your documents and pictures.

Einish Cancel

Figure 3-48. Map Network Drive dialog

In the Folder section, click Browse and then browse to the ScanServer
(\ScanServer_Name\client).

Ensure Reconnect at logon is checked.

Click Finish.
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3.8 Creating a desktop shortcut to the P: drive

For the sake of convenience, you can create a desktop shortcut to the P: drive,
which holds these commonly-used ClearCount programs:

« StartTabulator.cmd
« BallotDeleteBox.exe
« Update scripts for different scanner models and ballot sizes.

. This drive also holds some system files that must not be opened
except under the direction of Clear Ballot service personnel.

On a Windows 7 system

To create a shortcut to the P: drive on a Windows 7 system:

1. Login to the ScanStation computer as the Windows administrator.
2. From Windows Explorer, right-click the P: drive.

3. Right-click the file, and click Create shortcut.

4. Inthe Shortcut information box, click Yes.

A shortcut to the file appears on the desktop.

On a Windows 8.1 Pro system

To create a shortcut to the P: drive on a Windows 8.1 Pro system:

1. Login to the ScanStation computer as the Windows administrator.
2. From File Explorer, navigate to the top level (This PC).

3. Right-click the P: drive and click Create shortcut.

3.9 Configuring the scanner as a device

To ensure the ScanStation computer recognizes the scanner, the scanner must be
configured as a device.
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On a Windows 7 system

To configure the scanner as a device on a Windows 7 system:
1. Login to the ScanStation computer as the Windows administrator.
2. From the Windows Start menu, select Devices and Printers.

3. Inthe Devices and Printers window, look for the scanner. If it appears in
the Device list by name or model, you can close the window.

If the scanner is not listed by name or model (that is, if it appears as an

unidentified device), this may mean that the scanner software needs to be
reassociated with it.

To set the proper program to run when the Scan button is pressed:

1. Inthe Devices and Printers window, right-click the scanner and select
Scan Properties.

2. Depending on the computer’s settings, a User Account Controlinformation
box might appear. If it does, click Yes to allow the installation.

3. Click the Events tab.

_
£i-6800d] #2 Properties =

| General | Events | Color Management

2 Choose an event below, then select the action to take when that
\ﬁ event occurs.

Select an event: [_ﬁ Scan Button v]
Actions
@) Start this program: [L»,? ScandAll PRO v}

Prompt for which program to run

~) Take no action

[ 0K ] [ Cancel

S — — = 4

Figure 3-49. Events tab

4. Inthe Actions box, click Start this program and choose ScandAll PRO
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5.

from the dropdown list.

Click OK.

On a Windows 8.1 Pro system

To configure the scanner as a device on a Windows 8.1 Pro system:

1.

2
3.
4

Log in to the ScanStation computer as the Windows administrator.

. From the Start page, enter any letter key to launch the Search pane.

Enter device and then click Devices and Printers.

. Inthe Devices and Printers window, look for the scanner. If it appears in

the Device list by name or model, you can close the window.

If the scanner is not listed by name or model (that is, if it appears as an
unidentified device), this may mean that the scanner software needs to be
reassociated with it.

To set the proper program to run when the Scan button is pressed:

1.

In the Devices and Printers window, right-click the scanner and select
Scan Properties.

Depending on the computer’s settings, a User Account Controlinformation
box might appear. If so, click Yes to allow the installation.

Click the Events tab.
fi-6800dj Properties n

Genetal Events | Color Management

3 Choose an event below, then select the action to take when that
\)“ event occurs

Select an event: 8 Scan Button v
Achons
®) Start this program: l} Scand&l PRO v
Prompt for which program to run

Take no action

OK Cancel

Figure 3-50. Events tab
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4. Inthe Actions box, click Start this program and choose ScandAll PRO
from the dropdown list.

5. Click OK.

3.10 Running the scanner update script

A scanner update script sets the scanner profile and copies it into the directory
where ScandAll PRO expects to find it. Run the update script that corresponds to
the scanner model in use.

. The ScanStation operator must ask an administrator who knows the
administrative password for the station to run the update script.The
password must be kept from the ScanStation operator.
To run the scanner update script on Windows 7 or 8 systems:
1. Login to the ScanStation computer as the Windows administrator.

2. Double-click the desktop shortcut to the P: drive (created by mapping the
ScanStation to the ScanServer).

3. Double-click the appropriate update script:
« Update6140.bat for the fi-6140.
« Update5950.bat for the fi-5950.
« Update7180.bat for the fi-7180.
« Update6670.bat for the fi-6670.
« Update6800.bat for the fi-6800, if the ballot is less than 18 inches.

« Update6800-18-22.bat for the fi-6800, if the ballot is between 18 and 22
inches.
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4. When the script is finished, read the message to ensure the system
recognizes the scanner and serial number. The following shows the fi-6800
script:

C\Windows\system32\cmd.exe

P:\>set SCANNER_MODEL=6148
:\>SET SCANNER_PROFILE~=CBG fi-6140Z Profile

P:\>copy 7y "Fi6140\CBG fi-6140Z Profilex.»" “"C:\ProgramData\ScandAllPro\public_
iprofiles"
i61480°\CBG fi-6148Z Profile.ini
he system cannot find the path specified.
B file(s) copied.

:\>GetScannerInfo.exe
canner Model None, Scanner Serial None

\>set LOG=C:\Users\Deborah\AppData\Local\Temp\SetupScanner. log

P:\>SetupScanner.exe "6148" "CBG fi-6140Z Profile" ——log=C:\Users\Deborah\AppDat
a\Local\Tenp\SetupScanner. log

lindows~post2008Server-6.2.9200 Windows ver 2008
etupScanner ver 1.2 <(c) Clear Ballot Group h for options
%% error ** can not find ScandAll Pro

P:\J>pause

to continue .

— 1 1

Figure 3-51. Command window for scanner update script

5. Ifthe information is incorrect, try each of the following steps in order:

a. Turn off and restart the scanner and then rerun the script.
b. If (a) does not work, reboot the computer and rerun the script.

c. If (b) does not work, uninstall and reinstall the scanner drivers, using
your Fujitsu documentation.

d. If none of these troubleshooting steps work, contact Clear Ballot
Customer Support.

This process imports the proper profile onto the ScanStation from the
ScanServer and also imports the serial number of the scanner, so the
ScanStation computer/scanner combination can be identified later if issues
arise.

3.11 Configuring ScandAll PRO

The scanner profile and event are configured in ScandAll Pro.

. If you have not run the profile for a scanner model, as described in
Running the scanner update script on page 68, you cannot see it in the

ScandAll PRO dropdown lists. The update script must be run before

ScandAll PRO is opened, or else it does not display the new profile.

To configure ScandAll PRO on Windows 7 or 8 systems:
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1. Login to the ScanStation computer as the Windows administrator.
2. Open ScandAll PRO.

3. Select the proper profile from the dropdown menu as highlighted in the
following figure. The profile name matches the version of the update script
used as well as the scanner model.

2 ScandAll PRO - Untitled
File Scan Edit View Page Mark Zoom Tool Help

S 6@ @ = Qe & 16 B

B l_d: TCBG AB300 Profile VZ"‘. 2 | Y| = M |

x|

Figure 3-52. Scanner profile selection

. If the ScanStation computer is set up to work with more than
one scanner, you might have more than one profile. If you
cannot select the correct profile from the dropdown menu,
instead select Scan > Select Scanner. This opens the Select
Scanner dialog, in which you can select the correct scanner
profile.

4, From the Tool menu, select Preferences.

5. Inthe Setup editor, click the Event tab.
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6. Inthe Event list, click the Action associated with the Scan event to access
the dropdown list.

Setup n

Print | Scan | View | HotKey Event Password | Log File Format

Event list

Event Action A
Scan CBG H8800 Prohle v
Send to [Function1) Do nothing
Send to [Funclion2] (1)CBG FBB00 Profike
. CBG fiBs70 Profile
Send o (Functiond)
Send to [Funclions) Do nothing
Send to [Funchionb) Do nothing
Send to [Funclion?) Do nothing
Send to [Function3) Do nothing
Send to [Functiond) Do nothing
Send to [Funclion10) Do nothing
Send to [Function11) Do nothing
Send to [Function2) Do nothing
Send to [Funclion13) Do nothing v
Restore Defaults 0K Cancel Apply Help

Figure 3-53. Scanner event selection

7. Select the profile that matches your scanner and click OK.

8. Exit ScandAll PRO.

3.12 Testing the scanner cameras

The accuracy of the system depends not only on the correctness of the election
definition, but also on the proper functioning of the scanning equipment. The
following test ensures the scanners' cameras accurately record the images on
both sides of the ballots. This test involves the use of a calibration card and one
representative ballot of the size planned for the upcoming election.

Obtaining the calibration card

Print the two-sided calibration card at actual size (not fit to page) in landscape
orientation from Clear Ballot’s website (www.ClearBallot.com/Support/CalibrationCard).
Depending on your browser, you may need to print using the system dialog in
order obtain the landscape orientation option.
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Testing the cameras

To test the cameras, do the following for each configured scanner:

1.
2.
3.

5.

Log in to the ScanStation computer as the Windows administrator.

Run the scanner update script.

Run the calibration card and the representative ballot card through the
scanner. This produces four JPEG (.jpg) files, one for each side of each card.

Open the folder C:\CBGBallotimages and examine the JPEG files that start with
the prefix SEPARATOR. Look for the following:

« Both the front and back image of the calibration card are examined for
any distortion in the image. Lines should be sharp and straight. If there is
distortion, contact Fujitsu to service the scanner prior to using it in the
election.

. Both the front and back image of the representative ballot are examined
to ensure the entire ballot image is visible and that nothing was cropped
out by the scanner. If the ballot image appears cropped, contact Clear
Ballot Customer Support.

When the test is complete, delete the four images from C:\CBGBallotimages.

3.13 Setting Windows passwords

Administrative users must use a non-default password. Scanner operators are
required to have a password, which is not the Windows default. All passwords are
subject to Windows' complexity requirements. Tasks include:

1.

2
3.
4

Configure the Windows password policy.

. Change the administrative password.

Create the non-administrative user.

. Set up the non-administrative user.

. Prior to assigning passwords to individuals, give consideration to who

has the administrator password and which persons have a scanner
operator password.
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3.13.1 Configuring the Windows password policy

To configure the password policy on Windows computers:

1.
2.

10.

Log in to the ScanStation computer as the Windows administrator.

Access the Group Policy Editor:
On a Windows 7 system

a. Click the Start button.
b. In Search programs and files, enter gpedit.msc.
c. Inthe search results, click gpedit.

On a Windows 8.1 Pro system

From the Start page, enter gpedit. msc and then click gpedit in the search
results.

From the left pane, select Computer Configuration > Windows Settings
> Security Settings > Account Policies.

Click to open Account Policies.
Select Password Policy.

Within the Password Policies options displayed on the right, double-click
Minimum Password Length.

Set the length to 8 characters and press OK.

Within the Password Policies options displayed on the right, double-click
Password must meet complexity requirements.

Set to Enabled and press OK.

Close the Group Policy Editor.
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. Complexity requirements are enforced when passwords are changed

or created. If Password must meet complexity requirements is
checked, passwords must meet the following minimum requirements:

« Not contain the user's account name or parts of the user's full name that
exceed two consecutive characters.

» Be at least six characters in length.
« Contain characters from three of the following four categories:
o Latin uppercase characters (A through Z).
o Latin lowercase characters (a through z).
o Base 10 digits (0 through 9).
o Non-alphabetic characters (for example, !, $, #, %).

3.13.2 Changing the administrative password

. Never allow persons who are not system administrators to learn the

administrator password.

On a Windows 7 system

To change the administrative password on a Windows 7 system:

1.

=
©
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Log in to the ScanStation computer as the Windows administrator.
From the Windows Start menu, select Control Panel.

Select User Accounts.

Select Change your Password.

Enter the current password.

Enter the New Password.

Confirm the New Password.

Enter the Password Hint.

Click Change Password.

Log out of Windows.
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On a Windows 8.1 Pro system

To change the administrative password on a Windows 8.1 Pro system:

1.
2.

10.

11.
12.

Log in to the ScanStation computer as the Windows administrator.

From the Start page, slide the mouse to the top right corner to bring up the
side bar.

Select Settings.

From the Settings sidebar, select Change PC settings.
The PC Settings page appears.

Select Accounts.

The Accounts page appears.

Select Sign-in Options.
The Sign-in Options page appears.

Select Password.
Click Change.
On the next page, confirm current password and click Next.

On the next page, enter and reenter the new password, enter the password
hint and click Next.

On the next page, click Finish.

Log out of Windows.

3.13.3 Creating the non-administrative user

The non-administrative user account is for ScanStation operators. It is a standard
Windows account with the addition of a password. This user:

« Can run the Tabulator and DeleteBox programs.

« Requires the presence of the administrator to run the scanner update script

(to enter the administrative password).

On a Windows 7 system

To create the non-administrative user account on a Windows 7 system:

1.
2.
3.

Log in to the ScanStation computer as the Windows administrator.
From the Windows Start menu, select Control Panel.

Select User Accounts.
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On the next page select Manage Another Account.

On the next page select Create a New Account.

On the next page, enter the account name, select Standard User.
Click Create Account.

From the Manage Accounts page, select the new account.

W ® N o U bk

Click Change the Password.
10. Enter and reenter the password.
11. Enter a password hint.

12. Click Change Password.

On a Windows 8.1 Pro system

To create the non-administrative user account on a Windows 8.1 Pro system:

1. Login to the ScanStation computer as the Windows administrator.

2. From the Start page, search for Create an account.

The Manage Accounts page appears.

3. Select Add a new user in PC settings.
The PC Settings page appears.

4. Select Add an account.
The How Will that Person sign in page appears.

5. Select Sign in without a Microsoft Account (not recommended).

The first Add a User page appears.
Select Local Account (on the bottom).
Enter the user name (for example, Scan Op.)

Enter and reenter the password.

o ® N o

Enter a password hint and click Next.
The next Add a User page appears.

10. Click Finish.
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11.

To verify creation of the standard user:

a. From the Accounts page, select the new user.
b. Click Edit.

c. Verify the Account Type is set to Standard User.

3.13.4 Setting up the non-administrative user

To set up access to applications for the non-administrative user:

1.

Map the ScanStation computer to the ScanServer. See Mapping the
ScanStation to the ScanServer on page 62.

Create a desktop shortcut to the P: drive. See Creating a desktop shortcut to
the P: drive on page 65.

Create a desktop shortcut to ScandAll PRO:
a. Do as follows:
On a Windows 7 system
Open Windows Explorer.
On a Windows 8.1 Pro system
Open File Explorer (This PC).

b. Select C:\Program Files (x86)\fiScanner\ScandAll Pro.

c. Right-click ScandAllPro.exe.

d. From the context menu, select Send to.

e. From the Send to submenu, select Desktop (create shortcut).

Configure the scanner as a device. See Configuring the scanner as a device
on page 65.

Run the model-specific scanner update script. See Running the scanner
update script on page 68.

Configure the scanner profile and event in ScandAll PRO. See Configuring
ScandAll PRO on page 70.
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3.14 Viewing the Windows Event Log

The Windows operating system tracks application, hardware, security, system,
and other events in the Windows Event Log. You can use the Windows Event
Viewer to monitor the logging of all activities taking place on the Windows
computers used in the ClearCount system.

The Windows Event Log must not be disabled. ClearCount performs a check to
ensure the Windows Event Log has not been disabled every time Tabulator is run.
If the Windows Event Log is not enabled, a fatal error message is issued at
Tabulator startup.

Once you access it, Windows Event Viewer operates identically on Windows 7 and
Windows 8.1 Pro.

On a Windows 7 system

To access the Event Viewer on a Windows 7 system:

1. Log in to the ScanStation computer as the Windows administrator.

2. From the Control Panel, select System and Security > Administrative
Tools.

3. Double-click Event Viewer.

......

Figure 3-54. Windows Event Viewer
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On a Windows 8.1 Pro system

To access the Event Viewer on a Windows 8.1 Pro system, from the Start page,
enter event and select View Event Logs from the search results.

For more information on Windows Event Viewer

For details on using the Windows Event Viewer, consult the Event Viewer online
help, or follow these links for more information from Microsoft:

http://windows.microsoft.com/en-us/windows/what-information-event-logs-
event-viewer#1TC=windows-7

http://technet.microsoft.com/en-us/library/cc766042.aspx

http://technet.microsoft.com/library/jj134043

3.14.1 Viewing network connection and disconnection events

Windows logs network connections and disconnections by default, allowing you to
audit network activity.

On a Windows 7 system

To audit network events on a Windows 7 system:

1. Login to the ScanStation computer as the Windows administrator.
2. Click the Start > Control Panel.

Set View by: to Large icons.

Click Administrative Tools.

Double-click Event Viewer.

In the lefthand pane, expand Applications and Services Logs.

Select Microsoft > Windows > NetworkProfile.

© N o v & W

Select Operational.

All network connections and disconnections are displayed. (Double-click any
event to view its details.) Default display order is: Level, Date and Time,
Source, Event ID, and Task Category. The important items are Date and
Time, and, Event ID. Relevant values for Event ID include:

« 10000—Indicates a connection to the network.

o 10001—Indicates a disconnection from the network.
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On a Windows 8.1 Pro system

To audit network events on a Windows 8.1 Pro system:

1.

2
3
4.
5
6
7

Log in to the ScanStation computer as the Windows administrator.

. From the Start page, search for and open the Control Panel.

. Set View by: to Large icons.

Click Administrative Tools.

. Double-click Event Viewer.
. Inthe lefthand pane, expand Applications and Services Logs.

. Select Microsoft > Windows > NetworkProfile > Operational.

All network connections and disconnections are displayed. (Double-click any
event to view its details.) Default display order is: Level, Date and Time,
Source, Event ID, and Task Category. The important items are Date and
Time, and, Event ID. Relevant values for Event ID include:

« 10000—Indicates a connection to the network.

« 10001—Indicates a disconnection from the network.

3.15 Updating Windows Defender on ScanStations

Update Windows Defender virus definitions when configuring ScanStations and
then at least once a week. Please see Updating Windows Defender definitions on
page 102 for instructions.
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3.16 Restricting program access and adding application whitelists

Windows allows you to protect against unauthorized programs through the
following two steps:

« You implement a Software Restriction Policy (SRP), to prohibit
unauthorized programs by default.

« You establish a whitelist, which explicitly lists what programs and services are

permitted. The whitelist is created through a set of rules governing which
procedures are allowed.

. Make sure you install the Fujitsu software on all ScanStations, as
documented in Chapter 3, Configuring ScanStations, before setting
up your whitelists.

You restrict program access and add whitelists in the Group Policy Editor. The

process is the same on Windows 7 and Windows 8.1 Pro, but you access the Group
Policy Editor differently.
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3.16.1 Implementing a Software Restriction Policy (SRP)

To implement an SRP:

1. Access the Group Policy Editor:
On a Windows 7 system

a. Click the Start button.
b. In Search programs and files, enter gpedit.msc.
c. Inthe search results, click gpedit.

On a Windows 8.1 Pro system

From the Start page, enter gpedit.msc and then click gpedit in the search
results.

2. From the left pane, select Computer Configuration > Windows Settings
> Security Settings > Software Restriction Policies.
The Software Restrictions Policies page appears.

r

| Local Group Policy Editor =2 Eoh =<5

File | Action | View Help
L2 Aleal el 7 o

Computer Policy -

ymputer Configuration
Software Settings !
Windows Settings
| Name Resolution Po

No Software Restriction Policies Defined

Software restriction policies are not defined in this Group Policy object. If you define software
restriction policies in this Group Policy object, they will override inherited policy settings from other

=] Scripts (Startup/Shut Group Palicy objects.
= Deployed Printers
ié Security Settings To define software restriction policies, in the Action menu, click New Software Restriction Policies.

2 Account Policies
4 Local Policies |
| Windows Firewal |~
| Netwark List Mar.
| Public Key Policie
4| | Software Restricti
| Application Cont
&, IP Security Policie
| Advanced Audit |
ol Policy-based QoS
Administrative Template

Note: After initially creating software restriction policies, a reboot is required before they will be
enforced.

er Configuration
Software Settings

Windows Settings -
< n »

Figure 3-55. Software Restrictions Policies page

3. From the menu bar, click Action > New Software Restriction Policies.

This allows you to create a default set of software restriction policies.
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4. From the right pane, double-click the Security Levels folder.

The Security Levels folder opens.

Bl i Ven bep
YL ELE]

Local Compte iy
4 8 Compute Corfguration
Scftware Setings
4 Windows Setfings
Neme Reschation Pocy
= Scripts StartugShutdonry
o Deployed Priners
& [ Security Settings
3 MccountPoles
4 Lol Poics
Wi Firendl ith Adianced Secuity
Network it Manages Plcis
PubicKey Piiies
4 ] Software Pstrcion Plices
SecutyLevds
AdiicnalPuks
Contol Pocis

Zepix
8 1P Security Polices on Local Computer
Advanced it Paicy Configeaion
ol Pocrbase o
mirisrae Temgltes
+ & Use Confguraion
SeftureSettngs
Windsws Stngs
szt Temgltes

Local Group Poiicy

Ot Type
Security Levels
Addiional Pules
Errcement
Designated Fie Typs
TrusedPuishers

- oEm

Figure 3-56. Security Levels folder

5. From the right pane, double-click Disallowed.

File Action View Help

e aFEEE Hm

Local Group Policy Editor

- oW

2/ Local Computer Policy
4 8 Computer Configuration
| Software Settings
4 (71 Windows Settings
| Name Resolution Policy

9 Deployed Printers

4 T Security Settings
3 Account Policies

& Local Policies

7 Public Key Policies

| Security Levels
| Additional Rules

ol Policy-based QoS
, ] Administrative Templates
4§ User Configuration
, (5] Software Settings
| Windows Settings
| Administrative Templates

Figure 3-57. Access to Disallowed dialog from Group Policy Editor

The Disallowed Properties dialog appears.

] Scripts (Startup/Shutdown)

| Windows Firewall with Advanced Security
| Network List Manager Policies

4 [7] Software Restriction Policies
| Application Control Policies

@ 1P Security Policies on Local Computer
| Advanced Audit Policy Configuration

Name Description

llowed Software will not run, regardless of the access rights of the user.
=4 Basic User Allows programs to execute as  user that does not have Administrator ...
= Unrestricted Software access rights are determined by the access rights of the user.
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6. Click Set as Default and then click OK.

This ensures that, by default, the system does not allow any programs
without specific authorization to run.

Disallowed Properties ? n

=&

Disallowed

Description:

Software will not run, regardless of the access rights of the user.

Status: Default security level

Figure 3-58. Disallowed Properties dialog

7. Inthe Software Restriction Policies message box, click Yes.

Software Restriction Policies

The default level you selected is more restrictive than the current
! % default security level. Changing to this default security level may cause
some programs to stop working. Do you want to continue?

Figure 3-59. Software Restriction Policies commitment message

8. Click OK to dismiss the Disallowed Properties dialog.

3.16.2 Creating a whitelist

To create a whitelist:
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. Access the Group Policy Editor.

From the left pane, select Computer Configuration > Windows Settings
> Security Settings > Software Restriction Policies.

From the right pane, double-click the Additional Rules folder to open it.
This is where you create the whitelist.

] Local Group Policy Editor - o IEH
File Action View Help
& nE 0 . Hm

Software Settings A || Name ’ Type Security Level

4 [ Windows Settings i) KHKEY_LOCAL_MACHINE\SOFTWARE\.. Path Unrestricted

Name Resolution Policy & %HKEY_LOCAL_MACHINE\SOFTWAREL... Path Unrestricted
Seripts (Startup/Shutdown)

% Deployed Printers
- -:3 Security Settings
4 Account Policies
g Local Policies
Windows Firewall with Advanced Sec
Network List Manager Policies
Public Key Policies
] Software Restriction Policies
Security Levels
Addtional Rules
Application Control Policies
,! IP Security Policies on Local Comput
Advanced Audit Policy Configuratiol
ol Policy-based QoS
Administrative Templates
4 % User Configuration
Software Settings
Windows Settings v

Figure 3-60. Default rules in Group Policy Editor

Note that the following default rules to ensure the computer functions
normally:

¢ %HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\SystemRoot%—Allows normal Windows functions to
occur. It allows the system to boot normally, and provides access to
necessary programs such as Notepad and the Windows Event Viewer.
This rule must not be removed.

e %HKEY_LOCAL_
MACHINE\SOFTWAREMicrosoft\Windows\CurrentVersion\ProgramFilesDir%—
Enables the running of all executables in the Program files folder. If
unnecessary programs were removed in the procedure described in
Hardening, validating, and securing the system on page 101, then this
rule can remain. Otherwise, this rule should be removed and the
jurisdiction must create new path rules for the specific programs that it
needs to run.
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4. Create a path rule to allow access to files necessary for running scanners
and programs required for the system to function properly:

a. Right-click Additional Rules and select New Path Rule.

b. In Path, enter %HKEY_LOCAL_
MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\ProgramFilesDir

(x86)%.
c. Ensure the security level is set to Unrestricted.
d. (Optional)Enter a description for the rule.
e. Click OK.

. This rule allows access to 32-bit applications that are already
installed, and, to the 64-bit applications already permitted by
default.
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5. Create a path to the ClearCount server:

a.

b.

Right-click Additional Rules and select New Path Rule.

Enter the path to the ScanServer. The path is \Server_ Name\client,
where Server_Name is the name that was created for the ScanServer
during installation.

. Ensure the security level is set to Unrestricted.

. (Optional)Enter a description for the rule.

. Click OK.
\\cbgserver3\client Properties ? “
General
Q= Path Rue

Path:
\\cbgserver3\client

Browse...

Security level:
Unrestricted v
Description:
Clear Ballot Server
Date last modffied: Monday, April 28, 2014 3:38:13 PM

0K Cancel

Figure 3-61. ScanServer client properties

6. Create a path to enable all shortcuts (otherwise, to run a program the user
must navigate to the specific file location):

a.
b.

C.

Right-click Additional Rules and select New Path Rule.
In Path, enter *.Ink.

Ensure the security level is set to Unrestricted.

. (Optional)Enter a description for the rule.

. Click OK.
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7. Allow the Tabulator to run on the ScanStation:
a. Right-click Additional Rules and select New Path Rule.

b. In Path, enter %TEMP%)\BallotTabulator.exe.

c. Ensure the security level is set to Unrestricted.
d. (Optional)Enter a description for the rule.

e. Click OK.

8. Disallow Microsoft Paint from running on the ScanStation:
a. Right-click Additional Rules and select New Path Rule.

b. In Path, enter mspaint.exe.
c. Ensure the security level is set to Disallowed.
d. (Optional)Enter a description for the rule.
e. Click OK.
9. Close the Group Policy Editor.

After implementing the additional paths, the whitelist resembles the following:

" oo | 5[]

Eile  Action View Help
de = | 2 [ X E @ L= | E 6D

A Account Policies  » || Name ’ Type

1E) %HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\... Path
4E) %HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\... Path
" 47| S TEMP\Ballot Tabulator.exe Path

E|| ) =ik Path

4 Software Restrictio
e Al \\ebgeerveSiclient Path

Levels
Ad : al Rult | %HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\... Path

N retricte:
Application Contrc Ll mspaint.exe Path i

W, 1P Security Policies ™
it ] v

Figure 3-62. Example of modified whitelist

Additional entries can be created so the policy can adhere to local jurisdictional
regulations.

For additional information on SRP, both Microsoft’s TechNet and the National
Security Agency provide detailed descriptions of procedures and options for
creating a whitelist using SRP:

http://technet.microsoft.com/en-us/library/cc786941%?28v=ws.10%29.aspx

http://www.nsa.gov/ia/_files/os/win2k/Application_Whitelisting_Using_SRP.pdf

3.17 Denying access to USB drives

To deny access to USB drives:
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10.

11.

12.
13.

Log in to Windows as an administrative user.
Open the Microsoft Management Console (MMC):
On a Windows 7 system

From the Start menu, run mmc.exe and click Yes in response to the
prompt.

On a Windows 8.1 Pro system

From the Start page, search for and run mmc.exe, and click Yes in
response to the prompt.

Click File > Add/Remove Snap-in.

The Add or Remove Snap-ins window appears.

Select Group Policy Object Editor and click Add.

The Select Group Policy Object window appears.

Click Browse.

The Browse for a Group Policy Object window appears,
Select the Users tab.

Select Non-Administrators and click OK.

The Select Group Policy Object window contains a box hamed Group
Policy Object: that says Local Computer\Non-Administrators.

Click Finish.

Click OK.

Console 1 appears. The lefthand pane contains the applicable subset of
nodes from the Group Policy editor.

From the left pane, select Local Computer\Non-Administrators > User
Configuration > Administrative Templates > System > Removable
Storage Access.

Double-click All Removable Storage classes: Deny all access.

The All Removable Storage classes: Deny all access dialog appears.
Select Enabled.
Click OK.
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14. Save the console:

a. Select File > Save.
b. Ensure the default name is Console1.
c. Click Save.

15. Select File > Exit.
The MMC closes.

3.18 Powering down and restarting ScanStation computers

. Before continuing on to validation, you must complete the hardening
process by powering down and restarting every ScanStation
computer.

3.19 Validating software setup

The jurisdiction must validate that the system setup occurred properly, that no
files were corrupted, and that no unapproved files are present on the system
following an installation. If any issue is identified during the software setup
validation process then the entire system must be reinstalled, to ensure the
jurisdiction is working with a certified system.

3.19.1 Obtaining the list of all software files present on the system

Clear Ballot provides a list of all approved files present on a ClearCount
ScanServer along with the initial documentation provided to the election authority
for your state. This list includes SHA-256 file digests for each file on the system.
To access the list of all files on the system:
1. Login to an Election Administration Station computer as a Windows
administrator.

2. Login to ClearCount as administrator.
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3. From the Election Index page, click the down arrow next to the user name
(the login dropdown list) and then click About this software.

# Election Administration
# User Administration

# Server Background Jobs
Q Web Activity Log

O Logout

<-§ About This Softwaréz

Figure 3-63. About This Software menu item
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4. Inthe About this software page, click the ClearBallot Product Files tab
to view the ClearCount software, or the Installed System Packages tab
to view third-party packages included with the ClearCount software.

ClearBallot Build
2014-11-16 09:47:21

bie Owne File Oigen

Figure 3-64. Clear Ballot Product Files tab

Compare the official printed version of the ClearCount Approved Software
List to the About this software page for its installed version of ClearCount.
If the two lists do not match, then the system must be reinstalled. In
addition, if any of the file digests do not match, the system must be
reinstalled. If mismatches between the list from your state and your list
persist, notify your state election authority and Clear Ballot before
continuing to use the system.
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3.19.2 Initial register and variable validation

ClearCount’s initial register and variable values are located in the
CurrentElection.bat file. This file is located on the P: drive, which you mapped to
the ScanStations and Election Administration Stations as part of set up.

This file contains the values that are used to set the ELECTION and CBGSERVER
values in the system. Initially, both of these values should be empty. After the first
election has been created on a system (or once an election has been set to Active
following a restore), the variable ELECTION takes the value of the name of the
active election and the variable CBGSERVER takes the value of the name of the
ScanServer computer.

To verify that the values in CurrentElection.bat are empty:
1. Navigate to the P: drive.

2. Right-click CurrentElection.bat and click Edit.

) CurrentElertinn 541542
@) DeleteBoy Open

A GetScann

@) StartTabu Print

@] Updatel ®)  Run as administrator

@] Update66 Troubleshoot compatibility

& Updatet8 gy Scan with Microsoft Security Essenti:
@] Update68 & WinZip

%] UpdateT1 Restore previous versions

Figure 3-65. CurrentElection.bat, Edit menu item

3. Verify that the values in the file are empty, and then close the file.

| CurrentElection - Notepad

File Edit Format View Help

SET ELECTION=
SET CBGSERVERS|

Figure 3-66. Contents of CurrentElection.bat
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3.20 Testing the ScanStation configuration

Please see ClearCount readiness testing on page 138 and ClearCount Logic and
Accuracy testing on page 140.

3.21 Preparing for daily scanning

Before the start of scanning each day, or if you change the physical configuration,
walk through the scanning procedures described in ClearCount Election
Administrator’s Guide.
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Election Administration Stations connect to the ScanServer on a browser through
a closed, wired Ethernet network. Election Administration Stations require a small
amount of configuration, as follows:

« Mapping the Election Administration Station to the ScanServer
 Installing a supported browser
« Ensuring no extraneous software is installed on the computer
. After completing the steps in this chapter and before first use, you
must review and implement the hardening steps for all Election

Administration Stations specified in Hardening, validating, and
securing the system on page 101.

4.1 Mapping the Election Administration Station to the ScanServer

All of the ClearCount software resides on the ScanServer. It is necessary to
connect each Election Administration Station to the ScanServer through the router
in case files need to be shared. (For example, if there is a problem at a
ScanStation in the middle of scanning a box, you can use an Election
Administration Station to remotely delete the data it sent to the ScanServer.)

On a Windows 7 system

To map an Election Administration Station to the ScanServer on a Windows 7
system:

1. In Windows Explorer, select the C: drive and click Map network drive.

»rk Location (1

cbg (\cbgserver2) (P:)
|
= S5 GB free of 950 GE

3] Documents = Other (1

Figure 4-1. Map network drive selection

95



Chapter 4. Configuring Election Administration Stations

2. Inthe Map Network Drive dialog, select the P: drive.

® Map Network Drive
What network folder would you like to map?
Specify the drive letter for the connection and the folder that you want to connect to:
Drive P: v
Folder: v Browse..,

Example: \\server\share

¥ Reconnect at sign-in

¥ Connect using different credentials

nectto a Web site that you can use to store your docurnents and pictures.
Cancel

Figure 4-2. Map Network Drive dialog

3. Inthe Folder section, click Browse and then browse to the ScanServer

(\\ScanServer_Name\client).

4. Make sure that both Reconnect at logon and Connect using different

credentials are checked.

5. Click Finish.

On a Windows 8.1 Pro system

To map an Election Administration Station to the ScanServer on a Windows 8.1 Pro

system:
1. Inthe File Explorer, navigate to the top level (This PC).

2. From the Computer tab, click Map network drive to open the menu, and

then click Map network drive.

B0~ This PC - oIEl
2]
9= (5 Uninstall or change 3 program
= a #88 System properties
Open Control
Panel & Manage
v F P
"
[ Favorites 4 Folders (6)
Bl Desktop
& Downloads ! Desktop Documents L‘ Downloads
| Recent places
CBGBallotimages
8 | | ST B

Figure 4-3. Map network drive selection
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3. Inthe Map Network Drive dialog, select the P: drive.

R Map Network Drive

What network folder would you like to map?

Specify the drive letter for the connection and the folder that you want to connect to:

Drive P v
Folder:

Example: \\server\share

¥ Reconnect at sign-in

¥ Connect using different credentials

Connect to a Web site that you can u

& to store your documents and pictures.

v Browse..,

Cancel

Figure 4-4. Map Network Drive dialog

In the Folder section, click Browse and then browse to the ScanServer

(\\ScanServer_Name\client).

Click Finish.

4.2

Make sure that both Reconnect at logon and Connect using different
credentials are checked.

Creating a desktop shortcut to the P: drive

For the sake of convenience, you can create a desktop shortcut to the P: drive,
which holds these commonly-used ClearCount programs:

« StartTabulator.cmd

« BallotDeleteBox.exe

« Update scripts for different scanner models and ballot sizes.

On a Windows 7 system

This drive also holds some system files that must not be opened
except under the direction of Clear Ballot service personnel.

To create a shortcut to the P: drive on a Windows 7 system:

1. In Windows Explorer, right-click the P: drive.
2. Right-click the file, and click Create shortcut.
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3. In Shortcut information, click Yes.

A shortcut to the file appears on the desktop.

On a Windows 8.1 Pro system

To create a shortcut to the P: drive on a Windows 8.1 Pro system:

1. Inthe File Explorer, navigate to the top level (This PC).
2. Right-click the P: drive and click Create shortcut.

4.3 Installing a browser

In order to access ClearCount Election Reports and administrative applications,
you must have a supported browser installed on the Election Administration
Station. It is possible that the computer you are using as an Election
Administration Station came installed with a supported version of Microsoft
Internet Explorer. If not, orif you prefer to use a different browser, you need to
install one. (You may also install more than one of the supported browsers if you
choose.) For the list of supported browser versions, contact Clear Ballot.

. Because the computers used in an election must never be connected
to the Internet, you must download the browser software to a
computer that is connected to the Internet and copy the software to
the Election Administration Station.

To install a browser on an Election Administration Station:

1. On a separate computer with a USB port and an Internet connection,
navigate to the site from which the browser you want to install is distributed.

« Microsoft Internet Explorer: http://windows.microsoft.com/en-
us/internet-explorer/download-ie

« Mozilla Firefox: http://www.mozilla.org/en-US/firefox/new/
« Google Chrome: https://www.google.com/intl/en/chrome/browser/

2. Follow the instructions on the site of your choice to download the browser.

. If different operating system versions are available, ensure you download
the correct one for the targeted Election Administration Station.

. Note the name of the file and the path of the download location.

3. Insert a flash drive into the USB port of the computer you downloaded the
browser file to.

4. Copy the browser file to the flash drive.

5. Eject the flash drive from the download computer.
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v © N o

10.

4.4

Insert the flash drive into the Election Administration Station computer.
Copy the browser file to the Election Administration Station.
Eject the flash drive from the Election Administration Station.

Double-click the browser file to launch the installer, and follow the
instructions onscreen to complete the installation.

If there is more than one Election Administration Station, repeat steps 6
through 9 on each computer.

Installing Adobe Flash Player

. Adobe Flash Player is preinstalled with Internet Explorer on Windows 8

computers.

To install Adobe Flash Player:

1.

On a computer outside the closed ClearCount network, and which has a USB
port and Internet connection, navigate to
http://get.adobe.com/flashplayer/otherversions/.

The Adobe Flash Player Step: 1 of 3 page appears.

In Step 1, Select an operating system, select the operating system
running on the target Election Administration Stations.

In Step 2, Select a version, select the browser software in use on the
target Election Administration Stations.

Deselect the optional offer for McAfee Security Scan Plus.

Click Download Now.

The Adobe Flash Player Step: 2 of 3 page appears; wait for initialization
to progress to completion, when the opening__
installflashplayerVersionInformation dialog appears.

Click Save File.

The selected installer executable is saved to the current user's Downloads
folder as install_flashplayer Versioninformation.exe.

Copy the installer executable to the flash drive, and eject the flash drive
from the USB drive.

Insert the flash drive in the USB drive of an Election Administration Station.

Copy the installer executable to that computer, and eject the flash drive.
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10. Double-click the installer executable to launch the installation.

The User Account Control dialog appears.
11. Enter the Windows administrative password.

12. Follow the on-screen instructions:

a. Close the browser window (and any other applications named by the
installer) and click Retry.

b. Click Finish.

13. Repeat steps 8 through 12 on the other Election Administration Stations.

4.5 Avoiding extraneous software

The Election Administration Station is used only to communicate with the
ScanServer for system administration and reporting purposes. For security
purposes, it must not contain extraneous software.

In order to paste information copied from the Election Reports, you may use the
Notepad program, which is included on Windows computers by default. You may
then save the information as a text file and copy it onto a flash drive, from which it
can be moved to other computers and copied to programs such as Microsoft Excel.

Certain other programs and utilities may also be installed on the Election
Administration Station computer by default when you receive it from the
manufacturer. A Windows whitelist controls which software can run on the Election
Administration Station. For details, see Hardening, validating, and securing the
system on page 101.
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After the computers used in the ClearCount system are installed and configured
appropriately, you need to take the following steps to harden the system.
Hardening the ClearCount system makes it more secure from threats.

. Hardening the system includes procedural and environmental
elements that may be governed by local statute. Follow the steps in
every section below to harden your system; no steps are
"recommended" or "optional”. Make sure to consult local regulations
as part of the hardening process. Local voting system security
regulations may dictate that you do more than what is described in
this chapter.

5.1 Hardening the ScanServer

The ScanServer is a Linux server that is configured as an appliance. Once the
ClearCount software has been installed there is no need for any direct access to
the ScanServer other than during a support call with Clear Ballot. All normal pre-
election, election, and post-election access to the ScanServer is by remote
connection from the ScanStations or Election Administration Stations, all of which
are running on authenticated Windows workstations.

The Linux operating system requires at least one administrator account. Clear
Ballot conforms to this requirement by allowing customers to create an
administrator account with a password of their own choosing. Clear Ballot requires
that the password that is created at install time be secured. The administrator
account is never used, except as needed by Clear Ballot to diagnose a problem or
reinstall the software. (Reinstallation completely replaces the software; all
accounts initialized by the installation procedure are recreated.) To verify
compliance with this no-use policy, logins and logouts to the Linux server, if any,
are recorded in the Web Activity Log.

. If any unexpected logins to the ScanServer appear in the Web Activity
Log, the system might be compromised. Alert the appropriate
authorities for your jurisdiction, investigate the nature of these
unexpected logins, and reinstall the ClearCount software.

To completely harden the ScanServer, you must also set the BIOS password.
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5.2 Hardening the Windows computers

. The information in this section applies to Election Administration
Station and ScanStation computers.

Hardening the Windows computers in the ClearCount system consists of
minimizing routes of access to them, implementing malware protections, and
utilizing built-in logging features.

. Because the computers used in an election must never be connected
to the Internet, you must download any necessary software to a
computer with Internet access and copy it to the Election
Administration Station or ScanStation.

5.2.1 Updating Windows Defender definitions

Windows provides the Windows Defender antivirus program in both Windows 7
and Windows 8.1 Pro. In order to keep its virus definitions up to date, you must
update them. Microsoft recommends that Windows Defender be updated at least
once a week.

. Maintain the history and archive copies of each update.

Because computers used in elections must never be connected to the Internet, the
virus definition update must be done off line using removable memory media, as
follows.

On a Windows 7 system

To update Windows Defender offline on Windows 7 system:

1. On a computer outside the closed ClearCount network, and which has a USB
port and Internet connection, navigate to
http://support.microsoft.com/kb/923159/en-US.

2. Download the antivirus software according to the instructions on that site.

The software is delivered as a single executable named mpas-feX64.exe.

3. Insert a flash drive into the USB port of the computer you downloaded the
antivirus software to.

4. Copy the antivirus file mpas-feX64.exe to the flash drive.

5. Eject the flash drive from the download computer.
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6. Insert the flash drive into one of the Election Administration Station or
ScanStation computers.

7. Copy mpas-feX64.exe to that computer.
8. Eject the flash drive from that computer.

9. Double-click mpas-feX64.exe to launch the installer and follow the instructions
onscreen to complete the installation.

10. Repeat steps 7 through 9 on each Election Administration Station and
ScanStation computer.

On a Windows 8.1 Pro system

To update Microsoft Security Essentials off line on a Windows 8.1 Pro system:

1. On a computer outside the closed ClearCount network, and which has a USB
port and Internet connection, navigate to
http://support.microsoft.com/kb/923159/en-US.

2. Download the antivirus software according to the instructions on that site.

The software is delivered as a single executable named mpam-feX64.exe.

3. Insert a flash drive into the USB port of the computer you downloaded the
antivirus software to.

4. Copy the antivirus file to the flash drive.
5. Eject the flash drive from the download computer.

6. Insert the flash drive into one of the Election Administration Station or
ScanStation computers.

7. Copy the antivirus file to that computer.
8. Eject the flash drive from that computer.

9. Double-click the antivirus file to launch the installer, and follow the
instructions onscreen to complete the installation.

10. Repeat steps 7 through 9 on each Election Administration Station and
ScanStation computer.
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5.2.2 Enabling Windows Defender real-time protection

Real-time protection by Windows Defender must be enabled.

On a Windows 7 system
To enable real-time protection on a Windows 7 system:

1. From the Windows Start menu, search for defender.

2. From the search results, select Windows Defender.
The Windows Defender configuration interface appears.

3. Click Tools > Options > Real-time protection.
4. Check Use real-time protection (recommended).

5. Click Save and exit.

On a Windows 8.1 Pro system
To enable real-time protection on a Windows 8.1 Pro system:

1. From the Start page, search for defender.

2. From the search results, select Windows Defender.

The Windows Defender configuration interface appears.
3. Click Settings > Real-time Protection.
4. Check Turn on real-time protection (recommended).

5. Click Save changes and exit the dialog.
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5.3 Hardening scanners

To harden each scanner so that its firmware is protected, do as follows:

1. Verify the firmware through the Fujitsu Software Operation Panel:

a. From the Windows 8 Home page, enter Software Operation Panel.

b. From the search results, select Software Operation Panel.

The Software Operation Panel appears.

-
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Figure 5-1. Fujitsu Software Operation Panel

c. From the left pane, select Device Info.

d. From the right pane, expand Standard information.

e. Note the values of Product Identification (scanner model), Serial

Number, and firmware version.
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2. To protect the firmware:

a. Apply tamper-evident tape on the screws along the bottom exterior of
the scanner.

b. Press down the tape around the outside of each screw.

The secured tape is a seal that deters and provides evidence of any
manipulation of the scanner firmware.

3. Monitor the scanner for evidence of tampering.

. In the event of detecting unauthorized access to scanner
firmware, a jurisdiction must contact Clear Ballot and Fujitsu.
Only a licensed Fujitsu support technican can reinstall the
proprietary scanner firmware.

5.4 Hardening the router or switch

There are no actions that harden physical or software aspects of the router or
switch. Instead, the hardening of a router or switch involves limiting both physical
access to the router and its connections. No connections can be made to a system
that is not part of the ClearCount configuration. At no point can the router or
switch be connected to any outside network.

5.5 Logging unapproved processes

Attempts to access restricted or unapproved processes on the ScanStations or
Election Administration Stations are logged in the Windows Event Log.

5.6 Location security

Maintaining physical security of the ClearCount system is an important part of its
operation and maintenance. When the components of the ClearCount system are
not in use, they must be stored in a locked area under the custody and control of
the jurisdiction. Access to this area must be controlled by the jurisdiction so the
system cannot be accessed by unauthorized individuals and so that any breaches
in security can be recognized through the auditing functions of the system.

When in storage or in use, the ClearCount system must be kept within a controlled
area where only individuals authorized by the jurisdiction to handle and process
ballots or maintain the voting system can come into direct contact with the ballots
or components of the system. Each jurisdiction must also follow all jurisdictional
and state rules for the handling and processing of ballots in addition to this Clear
Ballot procedure. This means that one or more of these security methods are
employed to provide both deterrence as well as physical security:
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Receptionists or guards with a gate or other barrier to the scanning area.
« Security cameras.

« Electronic door locking mechanisms such as ID cards or key fobs that record
the identity of the device used to unlock the door.

A locking computer rack or other cabinet to contain components of the
ClearCount system.

. The ScanServer and attached router, as well as all data cable
connections in the ClearCount system are especially security

sensitive. When in use, segregate and enforce enhanced security over
the ScanServer, the ClearCount closed network router, and the
Ethernet cable connections to the ScanStations and if present, any
Election Administration stations on that closed network. As mentioned
elsewhere in this section, placing the ScanServer and routerin a
locked computer rack or an adjacent secure area, away from the
scanner operators is needed to maintain a proper system security
posture for ClearCount. Likewise, the jurisdiction must use cable locks
or tamper evident seals to provide an enhanced level of security over
the cable connections within the system.

The following figure is a simplified view of the application of a tamper-evident seal
to cable connections. Use tamper-evident tape to implement a seal that deters
and provides evidence of any manipulation of Ethernet connections. Apply the
tape as shown, taking care to bridge the computer body and Ethernet cable. (The
tape can instead be applied to the underside of the computer.) Ensure every
portion of the length of the seal is pressed against the computer body, cable
connector, or the cable itself for best tamper evidence.

Figure 5-2. Application of tamper-evident seal for Ethernet connections

107



Chapter 5. Hardening, validating, and securing the system

The jurisdiction must record whenever the ClearCount system is brought out of
storage, then after setting up the system examine the following logs to determine
if any unauthorized access occurred while the system was not officially in use:

o The Web Activity Log, which tracks ScanServer access.

« The Windows Event Logs on each ScanStation and Election Administration
Station computer. (See Viewing the Windows Event Log on page 78).

If there is a break in the custody and control of the jurisdiction, the jurisdiction
must reverify the integrity of the system and if necessary reinstall it.

At no point can any unauthorized hardware be connected to the system. The
tamper evident tape seals shown above can be applied to cover the Ethernet ports
in ScanServer and ScanStation computers to deter unauthorized connections. If
an unauthorized connection does occur, system integrity must be reverified.

5.6.1 Physical setup

Setting up the scanning location on page 112 provides detailed instructions on
setting up the work area where the scanning process takes place. This setup
facilitates the scanning process while also protecting the integrity of the ballots.

Clear Ballot setup instructions include the configuration of tables as well as the
placement of essential equipment in a dedicated scanning area. The equipment
layout follows a logical flow. The layout should be in order of the process steps for
scanning.

Clear Ballot recommends that the scanning location be located adjacent to the
ballot boxes or have the capacity to store and manage all the ballots to be
scanned. This minimizes potentially destabilizing ballot transit time and enables all
workers to view the entire operation. Mistakes in ballot handling, recording, or
scanning can be caught and corrected by other members of the election staff if a
single worker or team is engaged in a questionable behavior.

If sufficient space to manage and scan all of the ballots is not available in a single
section of the scanning location, then the jurisdiction must increase the number of
staff dedicated to ballot preparation and record-keeping to ensure proper ballot
control and accounting are maintained.
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5.6.2 Staffing

The scanning location itself must be secured. Unauthorized individuals must not be
allowed into the facility. Individuals who are not part of the jurisdiction’s
permanent staff must sign in and sign out at the entrance. The log of this activity
must be maintained.

The Clear Ballot model calls for both supervisors and record keepers to support
and monitor the work of ballot preparers and scanner operators. The supervisors
and record keepers ensure the smooth flow of ballot processing while keeping an
eye on overall process transparency.

The Clear Ballot recommended process takes into account human factors that
could potentially destabilize the ballot scanning process. If at any time a scanner
operator becomes confused about the appropriate response to a given situation,
he or she should stop scanning ballots immediately and alert the supervisor. The
supervisor, who has administrator-level access to the system, can log on using a
special secured password, resolve any issues, then return control to the scanner
operator.

5.6.3 Scanning operation workflow

The scanning process begins at the prep station. Ballots are delivered in boxes to
the prep station in accordance with the procedures of the jurisdiction for the
secure transfer of ballots. The prep station consists of a surface only, because the
purpose of this station is simply to unseal ballot boxes (if required), stage ballots
for the jogging station, and reseal ballot boxes. It does not matter how many
ballots are in each box or the order in which they arrived from the election
committee.

Before ballots are brought to the scanning area, the following steps must be
completed:

1. Set up a Ballot Preparation Table next to the scanning area.
2. Designate a second area, Ready for Scanning.

3. Print target cards and box labels by counter group (such as AB, EV, ED, or
oT).

4. Place target cards and labels under the Ballot Preparation Table.

The prep team assigns target cards and the corresponding labels to the ballot
boxes. The correspondence of these two items, as well as proper ballot handling
procedures when moving ballots from the scanner outstack to the ballot box,
facilitate image-to-ballot traceability™. The purpose of a target card is to inform
the scanner that a new box is being scanned and to assign the value of the
barcode as the BoxID prefix for all subsequent ballots.
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. A target card is similar to a header card used by other voting systems.

The purpose of a box label is to help locate the box that contains a ballot needed
for physical inspection. Ballots are stored in sequential order, starting with the
target card at the bottom of the box.

Additionally, any required ballot box record keeping occurs at the prep station.
Typically, the record keeper records all activity surrounding opening, recording,
and resealing sealed ballot boxes.

5.6.4 Handling of ballot boxes

The ClearCount workflow begins when the boxes of ballots to be counted are
delivered to the scanning location. Ballots must be transmitted securely, in
keeping with the jurisdiction's policies. For example, it is common for State Police
troopers to oversee the secure transport of ballot boxes from precincts to the
scanning location.

Once ballots enter the counting place, ClearCount relies on a combination of
staffing and site organization to marshal them securely through the workflow.

In the ClearCount setup, all work areas are specially laid out to minimize the
possibility of ballot disorder or misplacement. Work areas contain only the
necessary elements. There should be no extraneous items (such as extra
computer equipment or books) on any of the work surfaces.

ScanStations are designed with an implicit workflow in mind: in a ScanStation, a
ballot can be in one of three states: unscanned, scanning, and scanned. There is a
designated location for each of these states. Ballots are removed from a box,
placed in the unscanned pile to the left of the scanner. They are then sent through
the scanner and moved into the box to the right of the scanner once they finish
scanning.

The supervisor is responsible for monitoring all operations and ensuring any
interruptions in the process flow are dealt with properly and swiftly. The supervisor
is also responsible for ensuring proper procedures are being followed to protect
the ballot chain of custody and the tabulation process.

The record-keeper tracks all activity surrounding opening and resealing sealed
ballot boxes.

The prep staff prepares the ballots for scanning and moves them through the
workflow so the scanner operators can focus, uninterrupted, on their task. This
improves efficiency and minimizes the potential for confusion and errors.
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Scanner operators work on batches of ballots at a time. Their work areas are
specially laid out to minimize the possibility of confusion or misplacement. In their
training, scanner operators are taught that at the first sign of scanner problems or
operator confusion, they should alert the supervisor. The supervisor, meanwhile,
is trained to delete boxes from the system so the scanner operator can rescan
boxes that caused problems.

When scanning is complete, all ballots are returned to boxes (which now contain
target cards and box labels to facilitate ballot retrieval if needed at a later date).
The boxes are taken from the scanning area to a secure storage location to ensure
they remain protected and to ensure image-to-ballot traceability and system
integrity prior to a future audit or recount, until their allowable date of destruction.
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This chapter describes how to prepare your physical location for the ballot
scanning operation.

. Before setting up the scanning location, please familiarize yourself
with the physical security requirements described in Hardening,
validating, and securing the system on page 101.

6.1 Planning considerations

Before you begin setup, you need to determine the scale of your project.

6.1.1 Number of scanners needed

The number of scanners and ScanStations required depends on several factors,
including the:

« Number of ballots to be scanned.
« Time constraints on completing the scanning operation.

« The municipality’s budgetary constraints.

6.2 Planning location requirements

Along with determining staffing and equipment levels, you must also plan the
layout of the physical location where scanning takes place. Once the number of
scanners and ScanStations has been calculated, the physical location
requirements can be determined. The following are the recommended
specifications for physical location of the scanning operation as well as the
specifications for each of the associated stations.
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6.2.1 Workstations in a scanning operation

An end-to-end scanning operation requires the following work stations:

ScanStation

Consists of a scanner, a laptop or desktop computer, associated cables, and a
surface (typically a portable table) used to place the equipment and to provide
space for inbound and outbound ballots. A scanning operation might feature one or
more ScanStations.

ScanServer

Consists of a laptop or desktop computer, associated cables and a surface. This
station can use a smaller surface than a ScanStation, because no ballots or
scanners are present. A scanning operation features a single ScanServer.

Election Administration Station

Consists of a laptop or desktop computer and a surface. This station can use a
smaller surface than a ScanStation, because no ballots or scanners are present. A
scanning operation might feature one or more Election Administration Stations.

Ballot preparation/jogging station

Consists of a ballot jogger (used to align ballots prior to scanning, helping to
eliminate misfeeds and ensuring consistent ballot speed throughput) and space for
unjogged and already jogged ballots. This station typically uses a surface the
same size as the ScanStation.

Ballot handling station

Consists of a flat, clear surface. The purpose of this station is to unseal ballot
boxes (if required), apply box labels, stage ballots for the preparation/jogging
station and to reseal ballot boxes. Additionally, all ballot box record keeping
occurs here as required.

. For both security and organizational reasons, there should be no
extraneous items such as notebooks, folders, or coffee cups on any of
these surfaces.
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6.2.2 Physical location considerations

The following factors should be considered when choosing the physical location for
the scanning operation:

Proximity of ballots

Depending on the scale of the election jurisdiction, consideration should be made
for the transfer of ballots to the physical scanning location if required. The
scanning location should either be located adjacent to the ballot boxes or the
scanning location should have the capacity to securely store and manage all the
ballots to be scanned.

ScanStation space

Four feet of space behind each station is recommended so that scanning operators
and support personnel can pass unobstructed to and from ScanStations and
preparation/jogging station to deliver and retrieve ballots.

Electricity

Each ScanStation requires two electrical sources. The ScanServer station, Election
Administration Station, and preparation/jogging stations require one each. Be
prepared with extension cords and power strips to suit the scale of your scanning
operation. Consider the number of electrical outlets as well as their proximity to
the scanning operation.
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6.2.3 Physical requirements for workstations

The workstations in a scanning operation have the following physical
requirements:

6.2.3.1 ScanStation physical requirements

C Weight | Surface dimensions

The surface or table must be capable of A minimum of six linear feet and a depth
supporting the weight of the scanner, of no less than 2.5 feet per ScanStation is
computer, and ballots. The heaviest recommended.

component is typically the scanner.

Here are the scanner weight
specifications:

. fi-5950: 1101b

. fi-6670: 37 |Ib

o fi-6140: 101b

. fi-6800: 70 |Ib

. fi-7180: 101b

6.2.3.2 ScanServer/Election Administration Station physical requirements

C Weight | Surface dimensions

Minimal. Sufficient space for a large laptop
computer. (If the ScanServer is running
on a desktop computer, determine
required space accordingly.)

6.2.3.3 Preparation/Jogging Station physical requirements

30 Ibs. Six linear feet and a depth of no less 2.5
feet per station is recommended.

6.2.3.4 Ballot Handling Station physical requirements

— Weight | Surface dimensions

301b Six linear feet and a depth of no less 2.5
feet per station is recommended.
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6.2.4 Scanning operation physical layout best practices

The following figure illustrates the best practice physical layout for a scanning
operation, assuming four ScanStations, one ScanServer station, one Election
Administration Station, one jog station, and a ballot prep station. All four
ScanStations are connected to the ScanServer station using a router and an
Ethernet network.
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Figure 6-1. Example of scanning area physical layout

6.2.5 Scanner area guidelines

The scanning area is where the ballot scanning process takes place. The area must
hold computers, scanners, boxes, labels, and thousands of ballots. You need
approximately six feet of table space in order to accommodate a ScanStation’s
computer, scanner, and ballots. Lack of space can lead to disorganization and
mistakes.

There should be a logical flow to the layout of your equipment. The ScanStation
layout should match the order of the steps of scanning. The scanning process
begins with receipt from the prep station of a labeled box containing ballots and a
target card. These ballots become the input to the scanner, so the box should be
unpacked and the ballots placed to the left of the scanner. The empty box should
then be moved to the right of the scanner, either on the table or on the floor
directly in front of it. The ScanStation computer, meanwhile, should be either in
front of or directly beside its scanner. After the ballots are scanned, the scanner
operator places them, face down, into the output box. Upon completion of the box,
the scanner operator should initial the box label on the box, to indicate that the
box has been scanned.
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6.2.6 ScanServer area guidelines

The ScanServer connects physically to all ScanStations through the router, so it
needs to be located in close proximity to them. However, the scanning team does
not physically interact with the ScanServer.

6.2.7 Election Administration Station area guidelines

The Election Administration Station does not require a large surface, because it
does not have to hold a scanner or ballots. However, users interact with the
Election Administration Station, so it should be placed in an area with enough
space for one or two chairs to be placed in front of it.

6.2.8 Preparation station guidelines

This is the location where the process begins, with ballots being delivered in boxes
from the election committee. The ballot prep station consists of a surface only,
because the purpose of this station is simply to unseal ballot boxes (if required),
stage ballots for the jogging station, and reseal ballot boxes after scanning.
Additionally, any required ballot box record keeping occurs here.

The record keeper records all activity surrounding opening, recording, and
resealing sealed ballot boxes or bags.
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6.2.9 Jogging area guidelines

A stack of ballots might not be in optimal condition for scanning. As a result, you
may need to "jog" the ballots (that is, adjust them so they form a more orderly,
uniform stack) before placing them into the box. A properly jogged stack of ballots
is much less likely to result in a paper jam or misfeed. Within the jogging area,
there needs to be a centralized jogging machine to jog the ballots.

Additionally, target cards and box labels are affixed here. Affixing the box label
coincides with assigning a target card to a batch of ballots, as they both contain
the batch IDs. For example, if the target card indicates a batch ID of ED-11, then
you would affix a label marked ED-11 to the box where the ballots are to be
placed. This helps to identify the location of the ballots during the ballot
verification process.

The key tasks of the jogging area staff include:
a. Jogging the ballots.

b. Assigning a target card to each batch of ballots.
c. Affixing all labels to boxes.

d. Delivering boxes to and retrieving them from each ScanStation.

6.2.10 Security considerations

For security purposes, there cannot be WiFi components on the computers used in
the ClearCount system. The connection between the ScanStations and the
ScanServer must always be by wired Ethernet.

6.3 ScanStation equipment connections

After the equipment is set up, it must be connected as follows:

« Each scanner must be connected to its ScanStation computer.

« Each ScanStation computer must be connected to the Ethernet network.

Each scanner has a number of ports on the rear panel, as shown in the following
figures. The Power and USB ports are used.

. Scanner models fi-6800 and fi-6700 may have two square USB ports
on the rear panel. These ports are not interchangeable. The USB cable
must be plugged into the correct USB port as indicated by the
highlighted squares in the following photos.
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Model fi-6800

Figure 6-2. USB Port for the fi-6800
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Figure 6-3. USB Port for the fi-6670

Model fi-7180
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Figure 6-4. USB Port for the fi-7180
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Model fi-6140z

Figure 6-5. USB Port for the fi-6140z

Model fi-5950

Figure 6-6. USB Port for the fi-5950
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Two cables are required for each scanner:

« The power cable, which must be attached to the three prong male outlet on
the back and then to a working power supply. The following figure shows the

cable for fi-6670 and fi-6800. (The fi-7180 uses a circular pin-type electrical
connector with adapter.)

Figure 6-7. Power Cord

« A USB cable, which has a small square connection on one end and a flat,
rectangular connector on the other. The square end is placed into the similarly
sized outlet on the back of the scanner, while the flat, rectangular connector

should be placed into a USB port typically found on the back or sides of the
computer.

Figure 6-8. USB Cable

121



6.3 ScanStation equipment connections

The following figure shows a USB cable inserted into the USB connection on a
laptop.

Figure 6-9. USB Cable in a Laptop

Finally, the computer must be connected to the network so the scanned images
and data files can be sent to the ScanServer. The cable used is a standard
Ethernet network cable as shown in the following figure.

Figure 6-10. Ethernet Network Cable
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Each end of the Ethernet network cable is identical. One end is inserted into the
network port on the computer and the other end is inserted into the network
router. Additionally, the computer power cable must be attached to a working
power supply.

The following figure shows an Ethernet cable plugged into a laptop computer.

Figure 6-11. Ethernet Cable in a Laptop Computer

6.3.1 Turning on the hardware

After all the cables are connected, you can power on the elements of the
ClearCount system.

o To turn on the router, press its power switch.

« To turn on the scanner, press the power switch at the back of the scanner and
the power button.

The power button is located on the front of the fi-6800 and fi-7180 scanners, and
on the side of the fi-6670 scanner.

« To turn on each computer, press its power switch.

6.4 Preparing the scanner input and output mechanisms

After setting up the scanners, you need to configure a few of their physical
aspects.
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6.4 Preparing the scanner input and output mechanisms

6.4.1 Automatic document feeder setup on the fi-6800

For the scanner to successfully complete a batch scan on the fi-6800, the
Automatic Document Feeder (ADF) lever in the input hopper must in the down
position. When the gray leveris up (that is, within the housing case), the ADF is
not ready to guide documents into the scanner, and the scanner cannot function

properly.

The following shows the ADF lever in the up position (not ready to scan):

Figure 6-12. ADF lever in the up position on the fi-6800 scanner

Pull the gray lever down as shown to allow the ADF to assist in gathering
documents to ensure the scanner can function properly.

Figure 6-13. ADF lever in the down position on the fi-6800 scanner
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6.4.2 Input and output tray setup

It is important to adjust the input and output trays or hoppers to accommodate
the ballots being scanned. Ensure the trays are extended enough to properly hold
the full length of the ballot. Adjust the wings of the tray to loosely touch the edge
of the ballots. Wings that are too tight can result in twisted images, and wings that
are too loose can increase the risk of multifeeds and paper jams.

The following figure shows the trays and wings of a scanner.

Figure 6-14. Scanner Trays and Wings
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Chapter 7. About target cards and box labels

Before beginning the scanning process, you must print target cards and box labels.

« A target card identifies a batch or box of ballots. It informs the scanner that a
new box is being scanned and assigns the value of the barcode as the box ID
prefix for all subsequent ballots. (It is similar to the header card used in other
election systems.) A target card is typically printed on letter- or legal-sized
card stock.

. Target cards are not election-specific.

« A box label physically identifies each box and the corresponding ballots. Like
target cards, box labels contain unique identifiers. The box label is affixed to
the outside of the ballot box and should be consistently placed in the same
location (such as the upper right corner) to aid in quickly identifying ballot
boxes. Box labels are typically printed on Avery 5163 (2 inches x 4 inches)
label stock, with 10 labels per sheet.

Ballots within a box are in sequential order starting with the target card at the
bottom of the box. When a ballot is scanned, the front and back images are each
given a unique identifier (such as ED-001+00001 and ED-001+00002) corresponding
to the batch or box (ED-001) and image file (+00001).

The following figures show examples of a target card and box labels.
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Figure 7-1. Sample target card (not actual size)
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Figure 7-2. Sample box labels (not actual size)
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7.1 Naming of ballot image files

The naming convention for ballot image files is:

CounterGroup-BoxID+ BallotSequenceNo.jpg

where:

CounterGroup is the category of the ballots. Commonly used names include
Absentee (AB), Early Voting (EV), Election Day (ED), Provisional (PR), Other
(OT), and Ten-Day (TD).

. Counter group names are defined in the Ballot Definition File for an
election and can comprise up to eight ASCII uppercase characters
(A-2).
BoxID is the box sequence number.

BallotSequenceNlNo is the cardinal number of the image. Front sides are odd
and back sides are even. Target cards use 10001 and 10002 for their sequence
numbers.

The purpose of this naming convention is to provide reliable image-to-ballot
traceability, which makes it possible to retrieve an original ballot with precision.

The following table provides some examples.

Table 7-1. Ballot image file naming examples

Ballot description Image file

Front of AB Target AB-004+10001.jpg
Back of AB Target AB-004+10002.jpg
Front of 15t AB Ballot AB-004+10003.jpg
Back of 15t AB Ballot AB-004+10004.jpg
Front of 2"d ED Ballot ED-001+10005.jpg
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7.2 Downloading the target card and box label source files

Clear Ballot provides PDF file versions of the target cards and box labels that you
can print on site prior to the scanning process.

To download the target card and box label PDF files:

1. On a computer connected to a laser printer, navigate to the download area
of the Clear Ballot web site
(http://clearballot.com/Support/TargetsAndLabels).

2. Follow the instructions on the screen to download the necessary files.

To print target cards and box labels:

1. Open the directory holding the downloaded PDF files.

2. Locate and open the file for the particular target card or box label you want
to print.

3. Print the contents of the file, following the guidelines in Printing target card
and box labels below.

Quantity defaults to 500 or 1000 target cards. Ensure the printer
is set up for the required number of cards.

7.3 Printing target card and box labels

Target cards and box labels can be printed normally, keeping the following
guidelines in mind:

« Target cards should be printed on heavy (65 Ibs. or greater) card stock.
« Target cards should be printed on white card stock.

« Target cards and box labels should be printed on a laser printer. Target cards
and box labels contain bar codes which might not be readable if printed on an
inkjet or similar type of printer.
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7.3.1 Estimating printing requirements

The number of targets cards and box labels to print is determined by the number
of boxes for each type of ballot for the election.

« For Election Day at the polling place, print one target card per polling place or
precinct and/or scanner (for precincts that fill more than one box).

« Forother counter groups, such as Absentee (AB), Early (EV), Other (OT), Ten-
Day (TD), or Provisional (PR), print one target card for every 700 ballots
expected.

« For corresponding box labels, follow the same guidelines and divide by 10.
(Each sheet has 10 labels.)

Approximately 10% more targets cards and box labels should be printed than the
number of corresponding ballot boxes, in case additional target cards or box labels
are required during the scanning process due to ballot handing issues or scanning
errors.

. In elections with multipage ballots, multiply the calculated number of
target cards and box labels by the number of pages in a ballot to get
the proper total.

7.4 Paper requirements

For best scanning results, Clear Ballot recommends the use of paper weights
between 65 and 110 Ibs.

. ClearCount does not support ballots or target cards printed on colored
paper.
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Chapter 8. Creating elections and users
Before scanning, you must create the election as well as users. The following
privileges are required to create and manage:

« Elections - Access level of dbadmin or above.

« Users - Access level of useradmin or above.

. This chapter contains instructions on creating elections and users. For
instructions on modifying, deleting, or otherwise managing elections
and users, see ClearCount Election Administrator’s Guide.

8.1 Logging in as administrator

You log in to the administration pages using the DNS name for your ScanServer
that you set up during installation as your browser URL. For example:

http://ScanServer

In the Login dialog, enter the administrator’s username and password created
during the ClearCount installation.

<~

Clear Ballot

Please provide a username and a

Figure 8-1. ClearCount Login dialog
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8.2 Election naming rules and conventions

Election names must conform to the following rules:

Maximum of 64 characters.

May consist of lower- or uppercase letters, digits (0-9), underscores (_), and
dollar signs ($).

May begin with a digit but may not consist solely of digits.

May not contain forward slashes, backslashes, periods, colons, or any other
character not allowed in a typical file name in a folder.

May not contain single quotation marks, double quotation marks, or backticks
(grave accents).

May not end in a deliberate space.

For ease of use, Clear Ballot recommends that you name your election following
the convention used to name the associated BDF:

StateAbbreviation_JurisdictionName_ElectionNameAndType

For example:

ny_montgomery_2012g
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8.3 Creating an election

To create the election:

1. Ensure a zip archive of its Ballot Definition File (BDF) resides on the Election
Administration Station.

2. Onthe Election Administration Station, open a browser.

3. Loginto ClearCount as administrator.

4. From the Election Index page, click the down arrow next to the user name
(the login dropdown list) and then click Election Administration.

@cﬁon Administration )

# User Administration

# Server Background Jobs
Q Web Activity Log

O Logout

= About This Software

Figure 8-2. Election Administration menu item
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5. Inthe Election Administration page, click the Create Election tab.

& Clear Ballot

Election Administration

Home Create Election testore Election
New Election Name:
Ballot Definition Files (BDFs):
| Browse_ | No file selected

Create Election

Figure 8-3. Create Election tab

6. From the Create Election tab, do the following:

a. Enter the new election name, following the guidelines in Election
naming rules and conventions on page 132.

b. Browse to and select the BDF for this election. The relevant BDF zip file
was provided by Clear Ballot.

c. Click Create Election.

A new election is created and set as the active election. Newly scanned
ballots are considered to be part of the active election.
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8.4 Creating Election Administration Station users

After you create the election, you add users and assign them the appropriate level
of access. Each ClearCount user on your staff should have their own user account,
set with the precise permissions this user is allowed. By giving each user a
separate account, you can clearly identify each logged action by user.

All user names and passwords must satisfy the rules, and should meet the
guidelines, provided in ClearCount Election Administrator's Guide.

The following table describes increasing levels of access. Each level also includes
the privileges of any preceding level.

Table 8-1. User access levels

Access level Description

none No access to the system allowed. This setting may be used to
toggle a user’s access without deleting the user.

read User can view election reports, but he or she cannot modify
anything.

append User can add new database ballot records or new ballot images
by scanning. The ScanStation user has this level of access.

modify User can modify existing contents of the election through tools
that allow remaking or correcting.

dbadmin User can add or delete election databases as well as change a
database’s status. The dbadmin can give themselves modify
access to any new database they create.

useradmin User account management (the ability to add, modify, or delete

users).
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8.4.1 Adding a user

To add a user:
1. Inthe User Administration page, click the Browser Users tab.
2. Click Add User.

3. Inthe Add new user dialog, enter a user name and password for this user,
and then choose their access level from the Default Access dropdown list.
(User access levels are described in the User access levels table.)

Add new user

User Name

Default Access

none hd

Save Cancel

Figure 8-4. Add new user dialog

4. Click Save.

8.5 Preparing the zero report

After creating the election but before scanning any ballots, you can create a zero
report to prove that all vote totals are set to zero at the start of the election.

To produce the zero report:
1. Loginto ClearCount as administrator.

2. Inthe Election Index, select the election.

3. Inthe Dashboard, from the Report for Election_Name dropdown list,
click the Statement of Votes Cast.

4. Copy or print the report as needed. A copied report may be pasted into
Notepad and copied onto a flash drive for further distribution.
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8.6 Importing the CRF file

In order to see the ClearCount comparison reports, you must import the
Comparison Results File (or CRF). For more information about the CRF, see About
Comparison Result Files on page 5.

To import the CRF:
1. Copy the file onto the Election Administration Station.

2. Inthe Election Administration page, locate the row for the election you
want to compare.

3. Click the button in the Actions column and select Import Comparison
Results (CRF).

Phase Scan Date Tabulation Date Actions
scanning None None =
scanning None None =
scanning None None =
scanning None # Backup Election
scanning None < Z fmport Comparison Resﬂ@'
scanning None Wl Export Cast Vote Record
scanning None 2 Make Election no longer active

@l Delete Election
scanning None -
scanning None None =
scanning 2014-03-31 2014-03-31 i=

First Previous Next FF Last

Copy csv Print

Figure 8-5. Import Comparison Results menu item

4. Inthe Import Comparison Results File (CRF) dialog, browse to the CRF
file that you want to import and click Import.

Import Comparison Results File (CRF)

Existing Election Name:

f_leon_2010g_300dpi

Comparison Results File (CRF):

Browse.. | No file selected

Figure 8-6. Import Comparison Results File dialog
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This chapter describes the recommended workflow for ClearCount readiness
testing. Readiness testing ensures the system is in proper working order prior to
the start of the election.

All hardware that may be used in the election must go through readiness testing,
and data that verifies equipment must be obtained for it. Therefore, if the
jurisdiction intends to keep backup hardware on hand, the backup hardware must
go through readiness testing.

While not required, Clear Ballot recommends that the jurisdiction run additional
test ballots through the system to confirm that all ballot styles and counter groups
are handled appropriately.

. Readiness testing parameters may be governed by local statute.
Make sure you take local regulations into account as part of this
process.

9.1 Retesting the scanner cameras

The accuracy of the system depends not only on the correctness of the election
definition, but also on the proper functioning of the scanning equipment. The
following test ensures the scanners' cameras accurately record the images on
both sides of the ballots. This test requires a calibration card and one
representative ballot of the same size planned for the upcoming election.

Obtaining the calibration card

Print the two-sided calibration card at actual size (not fit to page) in landscape
orientation from Clear Ballot’s website (www.ClearBallot.com/Support/CalibrationCard).
Depending on your browser, you may need to print using the system dialog in
order obtain the landscape orientation option.

Testing the cameras

To test the cameras, do the following for each scanner in the ClearCount system:

1. Run the update script to configure scanner settings.

2. Run the calibration card and the representative ballot card through the
scanner. This produces four JPEG (.jpg) files, one for each side of each card.
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3. Open the folder C:\CBGBallotimages and examine the four JPEG files that start
with the prefix SEPARATOR. Look for the following:

« Both the front and back image of the calibration card are examined for
any distortion in the image. Lines should be sharp and straight. If there is
distortion, contact Fujitsu to service the scanner prior to using it in the
election.

« Both the front and back image of the representative ballot are examined
to ensure the entire ballot image is visible and that nothing was cropped
out by the scanner. If the ballot image appears cropped, contact Clear
Ballot Customer Support.

4. When the test is complete, delete the four images from C:\CBGBallotimages.
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Performing Logic and Accuracy (L&A) testing on the ClearCount system consists of
scanning a set of test ballots into the database created for the upcoming election
and then backing up and deleting the test data. This test must be performed on at
least one ScanStation. This test should be performed after readiness testing has
been completed.

Before doing L&A testing, do readiness testing to ensure every scanner works.

. L&A testing parameters may be governed by local statute. Make sure
you consult with election officials as part of this process.

10.1 Logic and Accuracy testing workflow
After you install the ClearCount software, use the following steps to test the
system.

1. Create an election using the BDF provided by Clear Ballot. This election is
used for the L&A test as well as for the election itself. For details on how to
create an election, see Creating an election on page 133.

2. Loginto ClearCount on the Election Administration Station and open the
Statement of Votes Cast report. (See ClearCount Election Administrator’s
Guide for details.) Use this report to ensure all contests and choices:

« Are accurate.

« Have zeroes in their totals.

. The empty Statement of Votes Cast is the zero report for the
ClearCount system. The report can be printed or exported if
needed.

Report any problems or unexpected results to Clear Ballot Technical
Support.

3. Log out of ClearCount.

4. Mark a set of test ballots, making sure that each position is marked and each
vote rule tested for each ballot style.

5. Print one target card for each counter group being used in the audit part of
this election. For details on printing target cards, see Chapter 7.
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6. For each ScanStation being used for the L&A test, verify the following:

a.

Using any of the target cards, scan the entire test deck. (See
ClearCount Election Administrator’s Guide for details.)

. On an Election Administration Station, log in to ClearCount and open

the Statement of Votes Cast report.

. Verify that the total results match the expected results for the test

deck. (The report may be printed or exported if needed.)

. Back up the election. (See ClearCount Election Administrator’s Guide

for details.)

. Log out of ClearCount.

Delete the box. (See ClearCount Election Administrator’s Guide for
details.)

7. After all scanners are tested, ensure all boxes are deleted by logging in to
ClearCount, opening the Statement of Votes Cast report, and making sure
that all contests and choices have zeroes in their totals.

8. Following the test, secure the ScanStation and ScanServer computers until
they are needed to process the audit.
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11.1 Uninstalling the ClearCount Software from the ScanServer

. You do not have to uninstall an older version of ClearCount before
installing a newer version.

If you need to remove the ClearCount software, wipe the hard disk on the
ScanServer computer.
11.2 Uninstalling supporting software from ScanStations

To uninstall supporting software from ScanStation computers, see the appropriate
one of the following guides:

Application Product documentation

ScandAll PRO 2.0 ScandAll PRO Release Notes
Premium
TWAIN drivers Fujitsu TWAIN 32 Scanner Driver User’s Guide
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This chapter describes how to break down and store the ClearCount equipment
after an election.

Breaking down the ClearCount system

After the election, all ClearCount hardware components should be powered down,
physically unplugged from their power supply and from the router, and packed.
Clear Ballot recommends that jurisdictions pack, transport, and store the
hardware used in the ClearCount operation in its original boxes. Alternatively,
jurisdictions have the option of purchasing custom scanner storage cases from a
third-party manufacturer. For details, contact your Clear Ballot representative.

The scanners used with ClearCount must be cleaned before being stored, following
the procedures outline in the Fujitsu Scanner Operator’s Guide for that
scanner model. In addition, while the scanners are opened for cleaning, check the
rollers for unevenness or other signs of wear, and if necessary, schedule a Fujitsu
service visit for prior to the next election.

Storing the ClearCount system

In between elections, jurisdictions are expected to store computers and scanners
in a secure, climate-controlled location. Jurisdictions should consult the model-
specific documentation for their commercial hardware to obtain specific guidance.
At a minimum, the following conditions for storage are required:

e 15-35degrees C
o 20 - 80% humidity
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Appendix A. ClearCount installation checklist
Individuals who install ClearCount software can use this form to record the various
user names and passwords they create during the installation.

. The ClearCount administrator or other responsible person must store
this confidential information in a safe and secure location.

. IP Address for the Server
. IP Address for the Router

. ScanServer Hostname

. Linux Administrator Username

. Database Root User Password

. ClearCount Admin Username

. ClearCount Admin Password

1
2
3
4
5. Linux Administrator Password
6
7
8
9

. ScanStation Password

10. BIOS Password
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